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Safety and Regulatory Information

Notices

© Keysight Technologies, Inc. 2013 - 2015

No part of this manual may be reproduced in any form or by any means (including electronic storage and
retrieval or translation into a foreign language) without prior agreement and written consent from
Keysight Technologies, Inc. as governed by United States and international copyright laws.

Manual Information

Part Number: 33500-90901

Manufacturer Address

Keysight Technologies, Inc.
900 S. Taft Ave.
Loveland, CO 80537 USA

Software and Documentation Updates and Licenses

Keysight releases software updates to fix defects and incorporate product enhancements. For the latest
firmware and documentation, see www.keysight.com/find/trueform.

A portion of the software in this product is licensed under terms of the General Public License Version 2
("GPLv2"). The text of the license and source code can be found at www.keysight.com/find/GPLV2.

This product uses Microsoft Windows CE. Keysight highly recommends that all Windows-based
computers connected to Windows CE instruments use current anti-virus software. For more information,
see www.keysight.com/find/trueform.

Warranty

The material contained in this document is provided "as is," and is subject to being changed, without
notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight disclaims
all warranties, either express or implied, with regard to this manual and any information contained herein,
including but not limited to the implied warranties of merchantability and fitness for a particular purpose.
Keysight shall not be liable for errors or for incidental or consequential damages in connection with the
furnishing, use, or performance of this document or of any information contained herein. Should Keysight
and the user have a separate written agreement with warranty terms covering the material in this
document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used
or copied only in accordance with the terms of such license.
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Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is
delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June
1995), or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as
defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use,
duplication or disclosure of Software is subject to Keysight Technologies’ standard commercial license
terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no
greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that,
if not correctly performed or adhered to, could result in damage to the product or loss of important data.
Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like
that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed
beyond a WARNING notice until the indicated conditions are fully understood and met.

Safety Symbols

Alternating current

Frame or chassis terminal (functional ground)

Standby supply. Unit is not completely disconnected from AC mains when switch is
off.

Risk of electric shock

Refer to accompanying documents
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Protective Earth ground terminal (safety ground)

The CE mark is a registered trademark of the European Community.

The ETL mark is a registered trademark of Intertek. Applies to 33500 Series instruments
only.

The CSA mark with the 'c' and 'us' subscript indicates the instrument is certified to the
applicable Canadian and United States of America standards respectively. Applies to
33600 Series instruments only.

The C-tick mark is a registered trademark of the Spectrum Management Agency of
Australia. This signifies compliance with the Australian EMC Framework regulations
under the terms of the Radio Communications Act of 1992.

Contains one or more of the 6 hazardous substances above the maximum
concentration value (MCV), 40 Year EPUP.

1SM 1-A This text indicates that the instrument is an Industrial Scientific and Medical Group 1
Class A product (CISPR 11, Clause 4).

ICES/NMB-
001

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme à la norme NMB-001 du Canada.

This product complies with the WEEE Directive (2002/96/EC) marking
equipment. The affixed product label indicates that you must not discard
this electrical/electronic product in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
www.keysight.com/environment/product/ for more information.

This equipment is Class A suitable for professional use and is for use in
electromagnetic environments outside of the home.

Additional Safety Notices

The following general safety precautions must be observed during all phases of operation of this
instrument. Failure to comply with these precautions or with specific warnings or instructions elsewhere in
this manual violates safety standards of design, manufacture, and intended use of the instrument.
Keysight Technologies assumes no liability of the customer’s failure to comply with the requirements.
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General

Do not use this product in any manner not specified by the manufacturer. The protective features of this
product may be impaired if it is used in a manner not specified in the operation instructions.

Before Applying Power

Verify that all safety precautions are taken. Make all connections to the unit before applying power.

Ground the Instrument

This product is provided with protective earth terminals. To minimize shock hazard, the instrument must
be connected to the AC power mains through a grounded power cable, with the ground wire firmly
connected to an electrical ground (safety ground) at the power outlet. Any interruption of the protective
(grounding) conductor or disconnection of the protective earth terminal will cause a potential shock
hazard that could result in personal injury.

l Do not operate in an explosive atmosphere.

l Do not operate the instrument in the presence of flammable gases or fumes.

l Only qualified, service-trained personnel who are aware of the hazards involved should remove
instrument covers. Always disconnect the power cable and any external circuits before removing the
instrument cover.

Do Not Modify the Instrument

Do not install substitute parts or perform any unauthorized modification to the product. Return the
product to an Keysight Sales and Service Office for service and repair to ensure that safety features are
maintained.

In Case of Damage

Instruments that appear damaged or defective should be made inoperative and secured against
unintended operation until they can be repaired by qualified service personnel.

Unless otherwise noted in the specifications, this instrument or system is intended for indoor use in an
installation category II, pollution degree 2 environment per IEC 61010-1 and 664 respectively. It is
designed to operate at a maximum relative humidity of 5% to 80% at 40 °C or less (non-condensing). This
instrument or system is designed to operate at altitudes up to 3000 meters, and at temperatures between
0 and 55 °C.
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Technical Support

If you have questions about your shipment, or if you need information about warranty, service, or
technical support, contact Keysight Technologies.

Declaration of Conformity

Declarations of Conformity for this product and for other Keysight products may be downloaded from the
Keysight Regulatory Web site:

http://regulations.products.keysight.com/DoC/search.htm
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Keysight Trueform Series Waveform Generator Operation and
Service Guide

This document includes user, service, and programming information for the Keysight Trueform Series
waveform generators.

For the latest firmware and documentation, see www.keysight.com/find/trueform.

For the latest datasheet with all specifications and typical characteristics, see
literature.cdn.keysight.com/litweb/pdf/5991-3272EN.pdf.

Keysight welcomes your comments and suggestions to improve our documentation. You can give
feedback on this document at www.keysight.com/find/trueformdocfeedback.
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Keysight BenchVue Software

The Keysight Trueform Series waveform generators work with BenchVue software, which provides easy
multi-instrument control. For more information, go to www.keysight.com/find/benchvue.

Use BenchVue to:

l View and control all of your bench instruments from a single screen

l Save/recall the state of your entire bench

l Acquire data and screenshots from multiple instruments

Save time with:

l Time aligned multi-instrument export to Excel, Word, MATLAB

l Export of waveform generator data to Word

l Drag and drop waveforms between your waveform generator and oscilloscope

l Integrated library capability for downloading instrument documentation, software drivers, firmware
updates, FAQs, videos, and more

From anywhere:

l Mobile companion apps to monitor and control your bench

Keysight Trueform Series Waveform Generator Operation and Service Guide
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Service and Repair Information

Service and Repair Introduction

Calibration and Adjustment: 33500 Series

Calibration and Adjustment: 33600 Series

Block Diagram - 33500 Series

Block Diagram - 33600 Series

Power Supplies - 33500 Series
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Troubleshooting - 33600 Series
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Installing the Optional GPIB Interface

IO Libraries and Instrument Drivers

The Keysight IO Libraries Suite software, including installation instructions, is on theKeysight IO
Libraries Suite CD provided with your instrument.

For information about connecting and configuring USB, LAN, and GPIB interfaces, refer to the Keysight
USB/LAN/GPIB Interfaces Connectivity Guide on theKeysight IO Libraries Suite CD, and at
www.keysight.com/find/connectivity.
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Web Interface

The instrument includes a built-in Web Interface. You can use this interface over LAN for remote
instrument access and control via a Java™-enabled Web browser, such as Microsoft Internet Explorer.

To use the Web Interface:

1. Establish a LAN connection from your PC to the instrument.

2. Open your PC's Web browser.

3. Launch the instrument's Web Interface by entering the instrument's IP address or fully-qualified
hostname in the browser address field.

4. Follow the instructions in the Web Interface's on-line help.

Example Programs

There are several example programs on the product page Web site (www.keysight.com/find/trueform).
These are application-focused programs that demonstrate different programming environments. This
document also includes programming examples to help get you started.

Keysight Trueform Series Operating and Service Guide 18
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Contacting Keysight Technologies

You can contact Keysight Technologies for warranty, service, or technical support.

In the United States: (800) 829-4444

In Europe: 31 20 547 2111

In Japan: 0120-421-345

Usewww.keysight.com/find/assist for information on contacting Keysight worldwide, or contact your
Keysight Technologies representative.

© Keysight Technologies, Inc. 2013 - 2015

Edition 3

September, 2015
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Models and Options
This section describes the models and options in the Trueform Series of instruments. For information on
loading licenses for options via the front panel, see License Installation. For information on loading
licenses via SCPI, see the SYSTem:LICense commands.

Instrument Models

Instrument models with numbers of the form 335XXA or 335XXB are referred to as the 33500 Series, and
instrument models with numbers of the form 336XXA are referred to as the 33600 Series. Collectively, the
33500 Series and 33600 Series instruments comprise the Trueform Series of waveform generators. Unless
specified otherwise, all manual topics apply to all instruments in the Trueform Series.

To determine the model number of your instrument, read the label on the instrument's front panel. You
can also either execute the *IDN? query over the remote interface or press [System] > Help > About on
the front panel.

The Trueform Series model numbers and option numbers are shown and described in the table below.

Model Description Options

33521A 30 MHz
One channel
Arbitrary waveforms
NISPOM Security
1 MSa Memory per channel

002 - 16MSa ArbMemory
004 - GPIB Interface
010 - High-stability OCXO Timebase

33522A 30 MHz
Two channels
Arbitrary waveforms
NISPOM Security
1 MSamemory per channel

002 - 16MSa ArbMemory
004 - GPIB Interface
010 - High-stability OCXO Timebase

33509B 20 MHz
One channel
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33510B 20 MHz
Two channels
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33511B 20 MHz
One channel
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33512B 20 MHz
Two channels
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33519B 30 MHz
One channel
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

Keysight Trueform Series Operating and Service Guide 20
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Model Description Options

33520B 30 MHz
Two channels
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33521B 30 MHz
One channel
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33522B 30 MHz
Two channels
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33611A 80 MHz
One channel
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33612A 80 MHz
Two channels
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33621A 120 MHz
One channel
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
GPB - GPIB interface module – factory installed

33622A 120 MHz
Two channels
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player
GPB - GPIB interface module – factory installed

Models and Options
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One- and two-channel upgrades for 33500 Series

Model Description

335BW1U Increase bandwidth to 30 MHz for one-channel models

335BW2U Increase bandwidth to 30 MHz for two-channel models

335ARB1U Add arbitrary waveforms to one-channel models

335ARB2U Add arbitrary waveforms to two-channel models

335MEM1U 16 MSa per channel memory for one-channel models

335MEM2U 16 MSa per channel memory for two-channel models

33500U-OCX Add high-stability OCXO timebase

335SECU Add NISPOM and File security

335IQPU Add IQ Baseband signal player

33522B-DST Enable all software options for demonstration

One- and two-channel upgrades for 33600 Series

Model Description

336BW1U Increase bandwidth to 120 MHz for one-channel models

336BW2U Increase bandwidth to 120 MHz for two-channel models

336MEM1U 64 MSa per channel memory for one-channel models

336MEM2U 64 MSa per channel memory for two-channel models

33600U-OCX Add high-stability OCXO timebase

336SECU Add NISPOM and File security

336IQPU Add IQ Baseband signal player

33622A-DST Enable all software options for demonstration

3446GPBU GPIB user installable interface module

Models and Options

This section describes the models and options in the Trueform Series of instruments. For information on
loading licenses for options via the front panel, see License Installation. For information on loading
licenses via SCPI, see the SYSTem:LICense commands.
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Instrument Models

Instrument models with numbers of the form 335XXA or 335XXB are referred to as the 33500 Series, and
instrument models with numbers of the form 336XXA are referred to as the 33600 Series. Collectively, the
33500 Series and 33600 Series instruments comprise the Trueform Series of waveform generators. Unless
specified otherwise, all manual topics apply to all instruments in the Trueform Series.

To determine the model number of your instrument, read the label on the instrument's front panel. You
can also either execute the *IDN? query over the remote interface or press [System] > Help > About on
the front panel.

The Trueform Series model numbers and option numbers are shown and described in the table below.

Model Description Options

33521A 30 MHz
One channel
Arbitrary waveforms
NISPOM Security
1 MSa Memory per channel

002 - 16MSa ArbMemory
004 - GPIB Interface
010 - High-stability OCXO Timebase

33522A 30 MHz
Two channels
Arbitrary waveforms
NISPOM Security
1 MSamemory per channel

002 - 16MSa ArbMemory
004 - GPIB Interface
010 - High-stability OCXO Timebase

33509B 20 MHz
One channel
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33510B 20 MHz
Two channels
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33511B 20 MHz
One channel
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33512B 20 MHz
Two channels
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33519B 30 MHz
One channel
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33520B 30 MHz
Two channels
No arbitrary waveforms

OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

Models and Options
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Model Description Options

33521B 30 MHz
One channel
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33522B 30 MHz
Two channels
Arbitrary waveforms

MEM - 16 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33611A 80 MHz
One channel
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security

33612A 80 MHz
Two channels
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player

33621A 120 MHz
One channel
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
GPB - GPIB interface module – factory installed

33622A 120 MHz
Two channels
Arbitrary waveforms

MEM - 64 MSa Memory per channel
OCX - Add High-stability OCXO Timebase
SEC - Enable NISPOM & File Security
IQP - Add IQ Baseband signal player
GPB - GPIB interface module – factory installed

One- and two-channel upgrades for 33500 Series

Model Description

335BW1U Increase bandwidth to 30 MHz for one-channel models

335BW2U Increase bandwidth to 30 MHz for two-channel models

335ARB1U Add arbitrary waveforms to one-channel models

335ARB2U Add arbitrary waveforms to two-channel models

335MEM1U 16 MSa per channel memory for one-channel models

335MEM2U 16 MSa per channel memory for two-channel models

33500U-OCX Add high-stability OCXO timebase

335SECU Add NISPOM and File security

335IQPU Add IQ Baseband signal player

33522B-DST Enable all software options for demonstration

Keysight Trueform Series Operating and Service Guide 24

Models and Options



One- and two-channel upgrades for 33600 Series

Model Description

336BW1U Increase bandwidth to 120 MHz for one-channel models

336BW2U Increase bandwidth to 120 MHz for two-channel models

336MEM1U 64 MSa per channel memory for one-channel models

336MEM2U 64 MSa per channel memory for two-channel models

33600U-OCX Add high-stability OCXO timebase

336SECU Add NISPOM and File security

336IQPU Add IQ Baseband signal player

33622A-DST Enable all software options for demonstration

3446GPBU GPIB user installable interface module

MaximumWaveform Frequencies by Model

33500 Series, Lower Frequency Models

33509B 33510B 33511B 33512B

Waveform Maximum Frequency

Sine 20 MHz

Square/Pulse 20 MHz

Noise 20 MHz

Ramp/Triangle 200 kHz

PRBS 50 Mbps

Arbitrary 160 MSa/s

33500 Series, Higher Frequency Models

33521A 33522A 33519B 33520B 33521B 33522B or other 33500 Series models with option 335BW1U
or 335BW2U.

Waveform Maximum Frequency

Sine 30 MHz

Models and Options
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Waveform Maximum Frequency

Square/Pulse 30 MHz

Noise 30 MHz

Ramp/Triangle 200 kHz

PRBS 50 Mbps

Arbitrary 250 MSa/s

33600 Series, Lower Frequency Models

33611A 33612A

Waveform Maximum Frequency

Sine 60 MHz up to 10 Vpp
80 MHz up to 8 Vpp

Square/Pulse 50 MHz up to 10 Vpp

Noise 60 MHz up to 10 Vpp
80 MHz up to 8 Vpp

Ramp/Triangle 800 kHz

PRBS 100 Mbps

Arbitrary 660 MSa/s

33600 Series, Higher Frequency Models

33621A 33622A or other 33600 Series models with option 336BW1U or 336BW2U.

Waveform Maximum Frequency

Sine 60 MHz up to 10 Vpp
80 MHz up to 8 Vpp
120 MHz up to 4 Vpp

Square/Pulse 50 MHz up to 10 Vpp
100 MHz up to 4 Vpp

Noise 60 MHz up to 10 Vpp
80 MHz up to 8 Vpp
120 MHz up to 4 Vpp

Ramp/Triangle 800 kHz

PRBS 100 Mbps up to 10 Vpp
200 Mbps up to 4 Vpp

Arbitrary 1 GSa/s
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Operating Information
Introduction to Instrument

Quick Start

Front Panel Menu Operation

Front Panel Menu Reference

LAN Configuration Procedure

Set Up Arbitrary Waveform

Features and Functions

Waveform Generation Tutorial

Introduction to Instrument

The Keysight Technologies Trueform Series is a series of synthesized waveform generators with built-in
arbitrary waveform and pulse capabilities.

Instrument at a Glance

Front Panel at a Glance

Front Panel Display at a Glance

Front Panel Number Entry

Rear Panel at a Glance

Instrument at a Glance

The instrument's combination of bench-top and system features makes it a versatile solution now and in
the future.

Convenient bench-top features

l 16 standard waveforms

l Built-in 16-bit (33500 Series) or 14-bit (33600 Series) arbitrary waveform capability

l Precise pulse waveform capabilities with adjustable edge time

l LCD display with numeric and graphical views

l Easy-to-use knob and numeric keypad

l Instrument state storage with user-defined names

l Portable, ruggedized case with non-skid feet

l Isolated outputs to break ground loops
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Flexible system features

l Downloadable waveform memory of 1MSa (33500 Series) or 4 MSa (33600 Series). This can be
upgraded to 16 MSa (33500 Series) or 64 MSa (33600 Series).

l USB, GPIB, and LAN remote interfaces (GPIB is optional on some models; see Models and Options for
details.)

l LXI Class C Compliant

l SCPI (Standard Commands for Programmable Instruments) compatibility
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Front Panel at a Glance

The BNC connectors, both the shell and center pin, on the front panel of the instrument are
isolated up to ±42 Vpk from chassis. The shells of these BNC connectors are connected to
each other, and internal circuitry will attempt to keep the isolated voltage to within ±42 Vpk
to chassis. Exceeding the isolation voltage beyond±42 Vpk from chassis may destroy the
instrument and cause a hazard that could result in personal injury or death.

Item Description

1 USB Port

2 On/Off Standby Switch

3 Display

4 Menu Softkeys

5 Fixed Function Buttons
(column of seven keys)

6 Manual Trigger Button

7 Sync Connector

8 Numeric Keypad

9 Channel 1 and Channel 2
(depending on model)

10 Knob and cursor arrows

Press and hold any front panel key or softkey to get context-sensitive help.
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Front Panel Display at a Glance

Item Description

1 Channel 1 information

2 Channel 2 information (depends on model)

3 Waveform parameters

4 Waveform display

5 Sweep, modulation, or burst parameters

6 Softkey labels

Operating Information

31 Keysight Trueform Series Operating and Service Guide



Front Panel Number Entry

You can enter numbers from the front panel in two ways:

l Use the knob and cursor keys to modify the number. Rotate the knob to change a digit (clockwise
increases). The arrows below the knob move the cursor.

l Use the keypad to enter numbers and the softkeys to select units. The [+/-] key changes the number's
sign.
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Rear Panel at a Glance

The rear panels on the 33500 Series and 33600 Series instruments have similar features, but their
locations vary, as shown below.

33500 Series

33600 Series

Item Description

1 External 10 MHz Reference Input

2 Internal 10 MHz Reference Output

3 GPIB Connector

4 Chassis Ground

5 Instrument Cable Lock

6 AC Power
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Item Description

7 External Modulation Input

8 External Trig/Gate/FSK/Burst (Input and Output)

9 USB Interface Connector

10 Local Area Network (LAN) Connector

The external 10 MHz reference input BNC connector, both the shell and center pin, on the
rear panel of the instrument is isolated up to ±42 Vpk from chassis. The shell of this BNC
connector is isolated from the rest of the instrument. Internal circuitry will attempt to keep
the isolated voltage to within ±42 Vpk to chassis. Attempts to float this input beyond±42 Vpk
from chassis may destroy the instrument and cause a hazard that could result in personal
injury or death.

The external modulation input BNC connector, both the shell and center pin, on the rear panel
of the instrument is isolated up to ±42 Vpk from chassis. The shell of this BNC connector is
connected to the shells of the front panel BNC connectors. Internal circuitry will attempt to
keep the isolated voltage to within ±42 Vpk to chassis. Attempts to float the outputs beyond
±42 Vpk from chassis may destroy the instrument and cause a hazard that could result in
personal injury or death.

This is a Protection Class 1 equipment (chassis must be connected to a protective earth ground).
The mains plug shall only be inserted in an outlet provided with a Protective Earth Terminal.

Quick Start

This section describes basic procedures to help you get started quickly with the instrument.

l Prepare Instrument for Use

l Adjust the Carrying Handle

l Set Output Frequency

l Set Output Amplitude

l Set DC Offset Voltage

l Set High-Level and Low-Level Values

l Output a DC Voltage

l Set Duty Cycle of a Square Wave

l Configure a Pulse Waveform

l Select a Stored Arbitrary Waveform
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l Use Built-in Help System

l Rack Mount the Instrument
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Prepare Instrument for Use

Verify that you received the following items. If anything is missing, please contact your nearest Keysight
sales office or Keysight authorized reseller.

l Power cord (for country of destination)

l Certificate of Calibration

l Keysight TrueformSeries Product Reference CD (product software, programming
examples, and manuals)

l Keysight IO Libraries Suite CD

l USB 2.0 cable

Note: All product documentation is on theKeysight TrueformSeries Product Reference
CD. For the latest firmware and documentation, see www.keysight.com/find/trueform.

The instrument may be used with mains power of either 100-240 V, 50/60 Hz or 100-120 V, 400 Hz. The
maximum power usage is 150 VA. Ensure that you are using the correctly rated mains cord based on the
instrument’s rating and your country's electrical codes. Connect the power cord and LAN, GPIB, or USB
cable as desired. Turn the instrument on by pressing the power switch in the lower left corner of front
panel. The instrument runs a power-on self test and then displays a message about how to obtain help,
along with the current IP address. It also displays the GPIB address if the GPIB option is installed and
enabled.

Power Switch:

The instrument's default function is a 1 kHz, 100 mVpp sine wave (into a 50 Ω termination). At power-on,
the channel output connectors are disabled. To enable output on a channel connector, press the key
above the channel connector and then press the Output Off / On softkey.

If the instrument does not turn on, verify that the power cord is firmly connected. Also make sure that the
instrument is connected to an energized power source. If the LED below the power switch is off, there is no
AC power connected. If the LED is amber, the instrument is in standby mode with AC power connected,
and if it is green, the instrument is on.

If the power-on self test fails, the display shows ERR in the upper right corner. It also prominently displays
"Check for error messages in the error queue."

See SCPI Error Messages for information on error codes. See Service and Repair - Introduction for
instructions on returning the instrument for service.

To turn off the instrument, hold the power switch down for about 500 ms. This prevents you from turning
the instrument off by accidentally brushing the power switch.
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Adjust the Carrying Handle

Grasp the sides of the handle, pull outward, and rotate the handle.
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Set Output Frequency

The default frequency is 1 kHz. You can change the frequency, and you can specify frequency in units of
period instead of Hz.

To change frequency with the knob:

To change frequency with the numeric keypad:

Finish by selecting frequency units:

To change the units to period instead of frequency:
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Set Output Amplitude

The instrument's default function is a 1 kHz, 100 mVpp sine wave (into a 50 Ω termination).

The following steps change the amplitude to 50 mVpp.

1. Press [Units] > Amp/Offs or High/Low to make sure that you are in Amp/Offs.

The displayed amplitude is either the power-on value or the amplitude previously selected. When you
change functions, the same amplitude is used if it is valid for the new function. To choose whether you
want to specify voltage as amplitude and offset or high and low values, press [Units] and then the
second softkey. In this case, we will highlight Amp/Offs.

2. Enter the magnitude of the desired amplitude.
Press [Parameters] > Amplitude. Using the numeric keypad, enter the number 50.
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3. Select the desired units.

Press the softkey that corresponds to the desired units. When you select the units, the instrument
outputs the waveform with the displayed amplitude (if the output is enabled). For this example, press
mVpp.

You can also enter the desired value using the knob and arrows. If you do so, you do not need to use a
units softkey. You can easily convert unit types. Simply press [Units] > Ampl As and select the
desired units.
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Set DC Offset Voltage

At power-on, the DC offset is 0 V. The following steps change the offset to –1.5 VDC.

1. Press [Parameters] > Offset.

The displayed offset voltage is either the power-on value or the offset previously selected. When you
change functions, the same offset is used if the present value is valid for the new function.

2. Enter the desired offset.
In this case we will use the numeric keypad to enter –1.5.

3. Select the desired units.
Press the softkey for the desired units. When you select the units, the instrument outputs the
waveform with the displayed offset (if the output is enabled). For this example, press V. The voltage
will be set as shown below.

You can also enter the desired value using the knob and arrows.
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Set High-Level and Low-Level Values

You can specify a signal by setting its amplitude and DC offset, described above. You can also specify the
signal as high (maximum) and low (minimum) values. This is typically convenient for digital applications. In
the following example, we will set the high level to 1.0 V and the low level to 0.0 V.

1. Press [Units] > Ampl/Offs to toggle to High/Low as shown below.

2. Press the [Parameters] > High Level. Using the numeric keypad or knob and arrows, select a value of
1.0 V. (If you are using the keypad, you will need to select the V unit softkey to enter the value.)

3. Press the Low Level softkey and set the value.
Again, use the numeric keypad or the knob to enter a value of 0.0 V.

These settings (high-level = 1.0 V and low-level = 0.0 V) are equivalent to setting an amplitude of 1.0 Vpp
and an offset of 500 mV.
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Output a DC Voltage

You can output a constant DC voltage, from -5 V to +5 V into 50 Ω, or -10 V to +10 V into a high
impedance load.

1. Press [Waveforms] > More > DC.
The Offset value becomes selected.

2. Enter the desired voltage offset.
Enter 1.0 with the numeric keypad or knob, and press the V softkey if you used the keypad.
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Set Duty Cycle of a Square Wave

The power-on default for square wave duty cycle is 50%. The duty cycle is limited by the minimum pulse
width specification of 16 ns on the 33500 Series, or 5 ns up to 4 Vpp and 8 ns up to 10 Vpp on the 33600
Series. The following procedure changes the duty cycle to 75%.

1. Select the square wave function.
Press [Waveforms] > Square.

2. Press the Duty Cycle softkey.
The displayed duty cycle is either the power-on value or the percentage previously selected. The duty
cycle represents the amount of time per cycle that the square wave is at a high level.

3. Enter the desired duty cycle.
Using the numeric keypad or the knob and arrows, select a duty cycle value of 75. If you are using the
numeric keypad, press Percent to finish the entry. The instrument adjusts the duty cycle immediately
and outputs a square wave with the specified value (if the output is enabled).
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Configure a Pulse Waveform

You can configure the instrument to output a pulse waveform with variable pulse width and edge time.
The following steps configure a 500 ms periodic pulse waveform with a pulse width of 10 ms and edge
times of 50 ns.

1. Select the pulse function.
Press [Waveforms] > Pulse to select the pulse function.

2. Set the pulse period.
Press the [Units] key and then press Frequency/Period to choose Period. Then press [Parameters]
 > Period. Set the period to 500 ms.

3. Set the pulse width.
Press [Parameters] > Pulse Width. Then set the pulse width to 10 ms. The pulse width represents the
time from the 50% threshold of the rising edge to the 50% threshold of the next falling edge.

4. Set the edge time for both edges.
Press the Edge Times softkey and then set the edge time for both the leading and trailing edges to 50
ns. The edge time represents the time from the 10% threshold to the 90% threshold of each edge.
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Select a Stored Arbitrary Waveform

There are nine built-in arbitrary waveforms stored in non-volatile memory. They are Cardiac, D-Lorentz,
Exponential Fall, Exponential Rise, Gaussian, Haversine, Lorentz, Negative Ramp, and Sinc.

This procedure selects the built-in "exponential fall" waveform from the front panel. For information on
creating a custom arbitrary waveform, refer to Set Up Arbitrary Waveform.

1. Press [Waveforms] > Arb > Arbs.

2. Choose Select Arb and use the knob to select Exp_Fall. Press Select.
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Use Built-in Help System

The built-in help system provides context-sensitive help on any front panel key or menu softkey. A list of
help topics is also available to assist you with several front panel operations.

View the help information for a function key

Press and hold any softkey or front panel key, such as [Waveforms]. If the message contains more
information than will fit on the display, press the down arrow softkey or use the knob to view the remaining
information.

Press Done to exit Help.

View the list of help topics.

Press [System] > Help to view the list of available help topics. To scroll through the list, press the up and
down arrow softkeys or use the knob. Select the topic Get HELP on any key and then press Select. Note
that the topics may vary from the list shown below, depending on model and firmware version.

Press Done to exit Help.
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View the help information for displayed messages.

Whenever a limit is exceeded or any other invalid configuration is found, the instrument displays a
message. The built-in help system provides additional information on the most recent message. Press
[System] > Help. Then select the topic View the last message displayed, and press Select.

Press Done to exit Help.

Local Language Help

All messages, context-sensitive help, and help topics are available in English, Chinese,
French, German, Japanese, Korean, and Russian. Softkey labels and status line
messages are not translated. To select the language, press [System] > System Setup
> User Settings > Help Lang. Then select the desired language.
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Rack Mount the Instrument

You can mount the instrument in a standard 19-inch rack cabinet using one of two optional kits, each of
which includes instructions and mounting hardware. Any Keysight System II instrument of the same size
can be rack-mounted beside the instrument.

Remove the carrying handle, and the front and rear rubber bumpers, before rack-
mounting the instrument.

To remove the handle, rotate it to vertical and pull the ends outward.

To remove the rubber bumper, stretch a corner and then slide it off.

Front Rear (bottom view)

To rack mount a single instrument, order adapter kit 5063-9240.

To rack mount two instruments side-by-side, order lock-link kit 5061-8769 and flange kit 5063-
9212. Be sure to use the support rails in the rack cabinet.

To prevent overheating, do not block airflow to or from the instrument. Air enters at the
rear of the instrument and exits at both sides and the bottom. Ensure that at least one
side is unblocked to allow the ventilation air to exhaust freely. Do not block the fan on
the instrument rear panel.

The 33600 Series instrument's fan speed runs at a constant speed up to an ambient
temperature of 28 °C and increases when the ambient temperature goes above 28 °C.

The 33600 Series instruments monitor critical internal temperatures and will shut down
if limits are exceeded. Failure of ventilation could result in shutdown.
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Front Panel Menu Operation

This section introduces front panel keys and menus. See Features and Functions, Front Panel Menu
Reference, LAN Configuration Procedure, and Set Up an Arbitrary Waveform for additional front panel
operation information.

l Select Output Termination

l Reset the Instrument

l Output a Modulated Waveform

l Output an FSK Waveform

l Output a PWM Waveform

l Output a Frequency Sweep

l Output a Burst Waveform

l Trigger a Sweep or Burst

l Store or Retrieve the Instrument State

Select Output Termination

The instrument has a fixed series output impedance of 50 Ω to the front panel channel connectors. If the
actual load impedance differs from the value specified, the displayed amplitude and offset levels will be
incorrect. The load impedance setting is simply a convenience to ensure that the displayed voltage
matches the expected load.

1. Press a channel output key to open the channel configuration screen. Note that the current output
termination values (both 50 Ω in this case) appear on the tabs at the top of the screen.

2. Begin specifying the output termination by pressing Output Load.

3. Select the desired output termination either by using the knob or numeric keypad to select the desired
load impedance or by pressing Set to 50 Ω or Set to High Z.

Reset the Instrument

To reset the instrument to its factory default state, press [System] > Set to Defaults > Yes.
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Output a Modulated Waveform

A modulated waveform consists of a carrier waveform and a modulating waveform. In AM (amplitude
modulation), the carrier amplitude is varied by the modulating waveform. For this example, you will
output an AM waveform with 80% modulation depth. The carrier will be a 5 kHz sine wave and the
modulating waveform will be a 200 Hz sine wave.

1. Select the function, frequency, and carrier amplitude.
Press [Waveforms] > Sine. Press the Frequency, Amplitude, and Offset softkeys to configure the
carrier waveform. For this example, select a 5 kHz sine wave with an amplitude of 5 Vpp, with 0 V
offset.

Note that you may specify amplitude in Vpp, Vrms or dBm.

2. Select AM.
Press [Modulate] and then select AM using the Type softkey. Then press the Modulate softkey to
turn modulation on. Notice that the [Modulate] key is illuminated, and the status message "AM
Modulated by Sine" appears at the top left of the display.

3. Set the modulation depth.
Press the AM Depth softkey and then set the value to 80% using the numeric keypad or the knob and
arrows.

4. Select the modulating waveform shape.
Press Shape to select the modulating waveform's shape. For this example, select a sine wave.

5. Press AM Freq. On the 33500 Series, you will first have to press the More softkey to get to the correct
menu. Set the value to 200 Hz using the numeric keypad or the knob and arrows. Press Hz to finish
entering the number if you are using the numeric keypad.
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Output an FSK Waveform

You can configure the instrument to "shift" its output frequency between two preset values (called the
"carrier frequency" and the "hop frequency") using FSK modulation. The rate at which the output shifts
between these two frequencies is determined by the internal rate generator or the signal level on the rear-
panel Ext Trig connector. For this example, you will set the "carrier" frequency to 5 kHz and the "hop"
frequency to 500 Hz, with an FSK rate of 100 Hz.

1. Select the function, frequency, and carrier amplitude.
Press [Waveforms] > Sine. Press the Frequency, Amplitude, and Offset softkeys to configure the
carrier waveform. For this example, select a 5 kHz sine wave with an amplitude of 5 Vpp, with 0 V
offset.

2. Select FSK.
Press [Modulate] and then select FSK using the Type softkey. Then press the Modulate softkey to
turn modulation on. Notice the status message "FSK Modulated" at the top left of the display.

3. Set the "hop" frequency.
Press the Hop Freq softkey and then set the value to 500 Hz using the numeric keypad or the knob
and arrows. If you use the numeric keypad, be sure to finish the entry by pressing Hz.

4. Set the FSK "shift" rate.
Press the FSK Rate softkey and then set the value to 100 Hz using the numeric keypad or the knob
and arrows.

At this point, the instrument outputs an FSK waveform if the channel output is enabled.

Keysight Trueform Series Operating and Service Guide 52

Operating Information



Output a PWMWaveform

You can configure the instrument to output a pulse width modulated (PWM) waveform. PWM is only
available for the Pulse waveform, and the pulse width varies according to the modulating signal. The
amount by which the pulse width varies is called the width deviation, and it can be specified as a
percentage of the waveform period (that is, duty cycle) or in units of time. For example, if you specify a
pulse with 20% duty cycle and then enable PWM with a 5% deviation, the duty cycle varies from 15% to
25% under control of the modulating signal.

To change from pulse width to pulse duty cycle, press [Units].

For this example, you will specify a pulse width and pulse width deviation for a 1 kHz pulse waveform with
a 5-Hz sine wave modulating waveform.

1. Select the carrier waveform parameters.
Press [Waveforms] > Pulse. Use the Frequency, Amplitude, Offset, Pulse Width and Edge Times
softkeys to configure the carrier waveform. For this example, select a 1 kHz pulse waveform with an
amplitude of 1 Vpp, zero offset, a pulse width of 100 µs, and an edge time of 50 ns (both leading and
trailing).

2. Select PWM.
Press [Modulate] > Type > PWM. Then press the first softkey (Modulate) to turn modulation on.
Notice the status message "PWM Modulated by Sine" in the upper-left corner of the display.
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3. Set the width deviation.
Press the Width Dev softkey and set the value to 20 µs using the numeric keypad or the knob and
arrows.

4. Set the modulating frequency.
Press the PWM Freq softkey and then set the value to 5 Hz using the numeric keypad or the knob and
arrows.

5. Select the modulating waveform shape.
Press Shape to select the modulating waveform's shape. For this example, select a sine wave.

To view the actual PWM waveform, you would need to output it to an oscilloscope. If you do this, you will
see how the pulse width varies, in this case, from 80 to 120 µs. At a modulation frequency of 5 Hz, the
deviation is easily visible.
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Output a Frequency Sweep

In the frequency sweep mode, the instrument moves from the start frequency to the stop frequency at a
sweep rate, which you specify. You can sweep up or down in frequency, and with either linear or
logarithmic spacing, or using a list of frequencies. For this example, you will output a swept sine wave from
50 Hz to 5 kHz.

1. Select the function and amplitude for the sweep.
For sweeps, you can select sine, square, ramp, pulse, triangle, PRBS waveforms, or arbitrary
waveforms (noise and DC are not allowed). For this example, select a sine wave with an amplitude of 5
Vpp.

2. Select the sweep mode.
Press [Sweep] and verify that the linear sweep mode is currently selected on the second softkey. Press
the Sweep softkey to turn sweep on. Notice the Linear Sweep status message at the top of the tab
for the current channel. The button is also illuminated.
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3. Set the start frequency.
Press Start Freq and then set the value to 50 Hz using the numeric keypad or the knob and arrows.

4. Set the stop frequency.
Press Stop Freq and set the value to 5 kHz using the numeric keypad or the knob and arrows.

At this point, the instrument outputs a continuous sweep from 50 Hz to 5 kHz if output is enabled.

You can also set the sweep frequency boundaries of the sweep using a center frequency and frequency
span. These parameters are similar to the start frequency and stop frequency (above) and they provide
added flexibility. To achieve the same results, set the center frequency to 2.525 kHz and the frequency
span to 4.950 kHz.

To generate a frequency sweep, press [Trigger] twice. The first press puts the trigger in manual mode, and
the second one sends a trigger. For more information, see Trigger Sweep or Burst.
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Output a Burst Waveform

You can configure the instrument to output a waveform with for a specified number of cycles, called a
burst. You can control the amount of time that elapses between bursts with the internal timer or the signal
level on the rear-panel Ext Trig connector. For this example, you will output a three-cycle sine wave with
a 20 ms burst period.

1. Select the function and amplitude for the burst.
For burst waveforms, you can select sine, square, ramp, pulse, arbitrary waveforms, triangle, or PRBS.
Noise is allowed only in the "gated" burst mode and DC is not allowed. For this example, select a sine
wave with an amplitude of 5 Vpp.

2. Select the burst mode.
Press [Burst] > Burst Off/On. Notice that a status message N Cycle Burst, Trig Imm is shown in the
tab of the current channel.
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3. Set the burst count.
Press # of Cycles and set the count to "3" using the numeric keypad or knob. Press Enter to finish
data entry if you are using the numeric keypad.

4. Set the burst period.
Press Burst Period and set the period to 20 ms using the numeric keypad or the knob and arrows. The
burst period sets the time from the start of one burst to the start of the next burst. At this point, the
instrument outputs a continuous three-cycle burst at 20 ms intervals.

You can generate a single burst (with the specified count) by pressing the [Trigger] key. For more
information, see Trigger Sweep or Burst.

You can also use the external gate signal to create gated bursts, where a burst is produced while a gate
signal is present on the input.

Trigger a Sweep or Burst

You can select one of four different types of triggers from the front panel for sweeps and bursts:

l Immediate or "automatic" (default): instrument outputs continuously when sweep or burst mode is
selected.

l External: triggering controlled by rear panel Ext Trig connector.

l Manual: initiates one sweep or burst each time you press [Trigger]. Continue pressing [Trigger] to re-
trigger instrument.

l Timer: issues one or more triggers a fixed time amount apart.

If sweep or burst is on, pressing [Trigger] displays the trigger menu. An illuminated [Trigger] key (solid or
blinking) indicates that one or both channels are awaiting a manual trigger. Solid illumination occurs when
the trigger menu is selected, and flashing illumination occurs when the trigger menu is not selected. The
[Trigger] key is disabled when the instrument is in remote.

Pressing [Trigger] when it is solidly illuminated causes a manual trigger. Pressing [Trigger] when it is
flashing selects the trigger menu; a second press causes a manual trigger.
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Store or Retrieve the Instrument State

You can store instrument states in any number of state files, (extension .sta). You can do this for backup
purposes, or you can save your state to a USB drive and load it on another instrument to have instruments
with matching configurations. A stored state contains the selected function, frequency, amplitude, DC
offset, duty cycle, symmetry, and any modulation or burst parameters in use. The instrument does not
store volatile arbitrary waveforms.

1. Select the desired storage location.
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2. Press Name and specify the name for the selected location.

33500 Series
To add characters, press the right-cursor key until the cursor is to the right of the existing name and
then turn the knob. To delete a character, rotate the knob until you get to the blank character before
the capital A. To delete all characters from the cursor position to the end of the line, press [+/-]. You
can enter numbers directly from the numeric keypad.

33600 Series
Use the front panel right and left arrows (under the knob) to select the characters to edit. You can go
past the final character to add a new character to the end. Then use the knob to select the desired
character and use the arrows to move to the next character to edit.

You can delete one or more characters with the Delete Char and Clear Entry softkeys.

Press Done when you have finished entering the name.

3. Store the instrument state.
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To restore (retrieve) a stored state:

Front Panel Menu Reference

This chapter begins with an overview of the front panel menus. The remainder of this chapter contains
examples of using the front panel menus.

Selects waveform

l Sine

l Square

l Ramp

l Pulse

l Arbitrary

l Triangle

l Noise

l PRBS

l DC

Configures waveform-specific parameters

l Period/Frequency

l Amplitude or High and Low Voltage

l Offset

l Phase
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l Duty Cycle

l Symmetry

l Pulse Width

l Edge Times

l Arbitrary Waveform

l Sample Rate

l Filter

l Arb Phase

l Bandwidth

l PRBS Data

l Bit Rate

Specifies unit and parameter preferences

l Arb Rate: Sa/s, Freq or Period

l Voltage as Amplitude/Offset or High/Low

l Voltage units as Vpp, Vrms, or dBm

l Pulse Width or Duty Cycle

l Burst Phase as Degrees, Radians, or Seconds

l Arb Phase as Degrees, Radians, Seconds, or Samples

l Frequency sweep as Center/Span or Start/Stop

Configures modulation parameters

l Modulation on or off

l Modulation type: AM, FM, PM, PWM, BPSK, FSK, or Sum

l Modulation source

l Modulation parameters (vary by modulation type)
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Configures frequency sweep parameters

l Sweep on or off

l Sweep type: Linear, logarithmic or frequency list

l Sweep time

l Start/stop frequencies or center/span frequencies

l Dwell, hold, and return times

Configures burst parameters

l Burst on or off

l Burst mode: triggered (N Cycle) or externally-gated

l Cycles per burst (1 to 100,000,000 or infinite)

l Starting phase angle of burst (-360° to +360°)

l Burst period

Stores and recalls instrument states

l Store instrument states in non-volatile memory.

l Assign custom names to storage locations.

l Recall stored instrument states.

l Delete stored instrument states.

l Select the instrument’s power-on configuration (last power-down or factory default).
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Configures instrument I/O interfaces

l Turn LAN on and off

l Configure LAN (IP address and network configuration)

l Reset the LAN

l Specify USB settings

l Select GPIB address

Performs system administration tasks

l Perform self-test

l Calibrate instrument

l Clear instrument memory (NISPOM secure)

l Install licensed features

l Update firmware
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Configures system-related parameters

l Set screen layout

l Select local language for front panel messages and help text

l Select how periods and commas are used in numbers on display

l Turn display on and off

l Enable or disable error beeper

l Enable disable keypad click

l Enable or disable screen saver

l Adjust display brightness

l Set date and time

l Manage files and folders (copy, rename, delete, screen capture, and so on)

l Configure 10 MHz reference oscillator

Shows list of Help topics

l View last message displayed

l View remote command error queue

l Get help on any key

l Learn how to obtain technical support

l View "about" data - serial number, IP address, firmware version, and so on
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Enables and configures channels

l Turn channel on and off

l Specify which channel is the focus of the menus

l Select output termination (1 Ω to 10 kΩ, or Infinite)

l Enable / disable amplitude autoranging

l Select waveform polarity (normal or inverted)

l Specify voltage limits

l Specify whether output is normal or gated

l Configure dual channel operation (coupling, tracking, and combine)

Configures trigger settings and sync output signal

l Perform a manual trigger, when illuminated

l Specify the trigger source for sweep, burst or arbitrary waveform advance

l Specify the trigger voltage level, count, and delay

l Specify the slope (rising or falling edge) for an external trigger source

l Specify the slope (rising or falling edge) of the trigger output signal

l Enable / disable the signal output from the "Sync" connector

l Specify the Sync source, polarity, mode, marker point, and so on

LAN Configuration Procedure

There are several parameters that you might need to set to establish network communication using the
LAN interface. Primarily, you will need to establish an IP address. You might need to contact your network
administrator for help in establishing communication with the LAN interface.

1. Select the "I/O" menu.
Press [System] > I/O Config.
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2. Select the LAN Settings menu.
Press the LAN Settings softkey.

You can select Modify Settings to change the LAN settings, or you can turn LAN Services on and off
or restore the LAN settings to default values.

This screen reflects the 33500 Series display. The 33600 Series also includes a LAN
Status indicator in the upper right corner to indicate whether the LAN connection is good
or faulty.

3. Press Modify Settings.

To access most items on this screen, use the first softkey to switch from DHCP to Manual. With DHCP
on, an IP address will automatically be set by DHCP (Dynamic Host Configuration Protocol) when you
connect the instrument to the network, provided the DHCP server is found and is able to do so. DHCP
also automatically deals with the subnet mask and gateway address, if required. This is typically the
easiest way to establish LAN communication for your instrument. All you need to do is leave DHCP on.
Contact your LAN administrator for details.
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4. Establish an "IP Setup."
If you are not using DHCP (if the first softkey is set to Manual), you must establish an IP setup,
including an IP address, and possibly a subnet mask and gateway address. The IP Address and
Subnet Mask buttons are on the main screen, and you press More to configure the Gateway.

Contact your network administrator for the IP address, subnet mask, and gateway to use. All IP
addresses take the dot-notation form "nnn.nnn.nnn.nnn" where "nnn" in each case is a byte value in
the range 0 through 255. You can enter a new IP address using the numeric keypad (not the knob).
Just type in the numbers and the period delimiters using the keypad. Use the left cursor key as a
backspace key. Do not enter leading zeros.

5. Configure the "DNS Setup" (optional)
DNS (Domain Name Service) is an Internet service that translates domain names into IP addresses. Ask
your network administrator whether DNS is in use, and if it is, for the host name, domain name, and
DNS server address to use.

a. Set the "hostname." Press Host Name and enter the hostname. A hostname is the host portion of
the domain name, which is translated into an IP address. The hostname is entered as a string using
the knob and cursor keys to select and change characters. The hostname may include letters,
numbers, and dashes ("-"). You can use the keypad for the numeric characters only.

b. Set the "DNS Server" addresses. From the LAN configuration screen, press More to go to the
second of three sets of softkeys.

Enter the Primary DNS and Second DNS. See your network administrator for details.
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More about IP Addresses and Dot Notation

Dot-notation addresses ("nnn.nnn.nnn.nnn" where "nnn" is a byte value from 0 to 255) must be expressed
with care, as most PC web software interprets byte values with leading zeros as octal (base 8) numbers. For
example, "192.168.020.011" is actually equivalent to decimal "192.168.16.9" because ".020" is
interpreted as "16" expressed in octal, and ".011" as "9". To avoid confusion, use only decimal values from
0 to 255, with no leading zeros.

Set Up an Arbitrary Waveform

The instrument includes an embedded waveform editor that allows you to create and edit arbitrary
waveforms. You can create these waveforms by editing voltage values directly or by using an combination
of up to 12 different kinds of standard waveforms.

The following tutorial creates and edits a basic waveform.

Insert Built-in Waveforms

1. Start the embedded waveform editor by pressing [Waveforms] > Arb > Arbs. Press Edit New, accept
the default file name, and then Start Editor. You now have a 0 VDC waveform of exactly 8 points
(33500 Series) or 32 points (33600 Series).

The rest of this tutorial is based on the embeddedwaveform editor in a 33500 Series
instrument, which has a minimum waveform size of 8 points. If you are using this tutorial
on a 33600 Series instrument, please note that the minimum waveform size for the
embeddedwaveform editor is 32 points.
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2. Press Insert Built-in > Choose Wave. Use the knob or the arrows below the knob to select D-Lorentz
and press OK. Use the keypad and the V softkey that appears when you start typing on the keypad to
set the Amplitude to 2 V, and then press OK. The waveform now has 100 additional points, as the D-
Lorentz waveform of 100 points was inserted in front of the initial waveform.

3. Suppose that you want to undo the change that you just made. Press [System] > Undo. You are now
back to the original 0 V waveform.

4. To put the D-Lorentz waveform back, press Redo. Then press Done to exit.
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5. Now we will insert a sine wave. Begin by pressing Choose Wave. Make sure Sine (the default) is
highlighted, and press OK. For help in understanding the various parameters on the screen, press
Parameter Help. Then press Done to exit the help screen.

6. Using the numeric keypad and the up and down arrow softkeys, set the Amplitude to 3.5 V, the
Cycles to 4, and the Points to 200. Leave all other settings at their default values and press OK.

7. Notice that the first softkey, Select Point # is highlighted. Put the marker on the 270th waveform
point by using the numeric keypad to enter the number 270 and pressing Enter.
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8. Press Choose Wave, select Square, and then press OK. Set the Amplitude to 3 V, the Offset to -2 V,
the Cycles to 8, and the Points to 100. Press OK. Notice that the 8 square wave cycles have been
inserted, beginning at the marker. Press Done.
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Edit Waveform Characteristics

1. Press Edit Params and then set the Sampling Rate to 100 Sa/s. Press Cycle Period and notice that it
has been set to 4.08 seconds. This is because you have 408 sample points in the waveform, and the
sample rate is 100 Sa/s.

2. Change the Cycle Period to 2.04 seconds and then press Sampling Rate. It will now be set to 200
Sa/s in order to play the 408 point waveform in 2.04 seconds.

3. Press Done to exit the parameter editing screen. Press Edit Points and notice that the Point # softkey
is highlighted. Enter the number 160 and press Enter to move the marker.
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4. Press Voltage and change the voltage of the selected point to 4.2 V. Press Point # and change the
point marker to 150 to move the marker off the point. When you press Enter to finish entering point
150, you will see the 4.2 V anomaly in the wave that you just created at point 160.
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Zoom and Pan

1. To see the point in detail, press [System] > Pan/Zoom Control. Notice that the first softkey is set to
Horizontal, meaning that the zooming that we are about to do will be along the horizontal (time) axis.
Change the Zoom to 500%, and the sine wave anomaly will be more obvious.

2. Now set the first softkey to Vertical to zoom vertically. Set the Zoom to 500%. Notice that we have
zoomed in on the voltage axis, but we are too low to see the 4.2 V anomaly in the sine wave.

3. Press Pan and set the Pan to 3 V in order to move higher on the waveform. The 4.2 V point is now
clearly visible.
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4. To see the entire waveform again, press Show All. Then press Done and Done again to return to the
Edit Points screen.

Insert, Remove, Copy and Paste Points

1. Press Insert Point 15 times and watch the display carefully. You will see 15 new waveform points at
the same voltage level.

2. Change the Point # to 220 and press Remove Point 20 times, watching the display carefully as you
do so in order to see the points being removed from the waveform.
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3. You can also edit points by using a table of voltages. Press Advanced Edit > Edit Via Table. Set Point
# to 200, and then set the Voltage for point 200 to 3 V. Use the knob to move between rows and set
the Voltage for points 205 and 210 to 3 V. Press Done.

4. Notice the three 3 V spikes that you just made in the waveform at points 200, 205, and 210.

5. Press Cut/Copy Paste, and set Marker 1 to 150. Then press the first softkey and change the Marker
to Marker 2. Set Marker 2 to 300. The range defined by the markers is now highlighted in black.

6. Press Copy, then Paste, and then At Start. Notice that section you copied is now duplicated at the
beginning of the waveform.
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7. Now press Paste > At End. The same section of the waveform now also appears at the very end.

8. Now press Paste and change the Point # to 500. Then press OK, and the same portion of the
waveform will be pasted in at point 500. Press Done to leave the Cut/Copy Paste menu.
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Perform Math

The embedded waveform editor allows you to perform mathematical operations on the waveform. First
you set markers to define the range of the waveform that you want to modify. You can then add, subtract
or multiply that portion of the waveform by another waveform, or you can transform the waveform in ways
that do not involve other waveforms.

1. Press Perform Math. Set Marker 1 to 400 and Marker 2 to 500.

2. Press Add, then select Haversine and OK. Set the Amplitude to 3 V, the Offset to 0 V, and press OK.
Notice that the highlighted section now rises in the middle as a result of the Haversine addition.

3. Now press Multiply and select the Sine wave (press OK). Set the Cycles to 2 and press OK.
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4. Now set Marker 1 to 200 and Marker 2 to 600.

5. Press Advanced Math > Mirror > OK.

6. Continue learning about the interface by trying other Advanced Math features, such as Invert,
Absolute, Scale, and so on. Press Operation Help for more information.

Features and Functions

This section contains details on instrument features, including front panel and remote interface operation.
You may want to read Front Panel Menu Reference first. See SCPI Programming Reference for details on
SCPI commands and queries. This section covers:

Output Configuration

Pulse Waveforms

Amplitude Modulation (AM) and Frequency Modulation (FM)

Phase Modulation (PM)

Frequency-Shift Keying (FSK) Modulation

Pulse Width Modulation (PWM)

Sum Modulation

Frequency Sweep

Burst Mode

Triggering

Dual Channel Operations

IQ Player (Optional)
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System-Related Operations

Remote Interface Configuration

External Timebase Reference

Embedded Waveform Editor

Throughout this document, "default" states and values are identified. These are the power-on default
states provided you have not enabled the power-down recall mode (see Instrument State Storage).

Output Configuration

This section describes output channel configuration. Many commands associated with output
configuration start with SOURce1: or SOURce2: to indicate a certain channel. If omitted, the default is
channel 1. For example, VOLT 2.5 sets the output on channel 1 to 2.5 V, and SOUR2:VOLT 2.5 does the
same for channel 2.

The instrument's display includes a "tab" for each channel that summarizes various aspects of each
channel's output configuration:

On a two-channel instrument, the tab for channel 1 will be yellow, and the tab for channel 2 will be green.

Output Function

The instrument includes eight standard waveforms: sine, square, ramp, pulse, triangle, noise, PRBS
(pseudo-random binary sequence), and DC. There are also nine built-in arbitrary waveforms, and you can
create custom waveforms with the embedded waveform editor.

The table below shows which functions are allowed (•) with modulation, sweep, and burst. Selecting a
function that is not allowed with a modulation or mode disables the modulation or mode.

Carrier AM FM PM FSK BPSK PWM Sum Burst Sweep

Sine and Square • • • • • • • •

Pulse • • • • • • • • •

Triangle and Ramp • • • • • • • •

Gaussian Noise • • •a

PRBS • • • • •

Arbitrary Waveform • • •b •b • • •

Sequence • •

(a) Gated burst only

(b) Applies to sample clock, not whole waveform
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l Frequency Limitations: Changing functions may change the frequency to meet the new function's
frequency limits.

l Amplitude Limitations: When the output units are Vrms or dBm, changing functions may lower the
amplitude to the maximum for the new function due to variation in waveform shapes. For example, a 5
Vrms square wave (into 50 Ω) changed to a sine will decrease to 3.536 Vrms (sine’s upper limit).

l Amplitude and offset cannot combine to exceed the instrument’s capability. The one you set last may
be changed to stay within limits.

l You may protect a device under test (DUT) by specifying upper and lower output voltage limits.

l Front Panel:

To select another waveform:

l For example, to specify a DC signal:

To produce the DC output:

l SCPI: [SOURce[1|2]:]FUNCtion <function>

The APPLy command configures a waveform with one command.
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Output Frequency

The output frequency range depends on the function, model, and output voltage, as shown here. The
default frequency is 1 kHz for all functions, and the minimum frequencies are shown in the table below.

Function Minimum Frequency

Sine 1 µHz

Square 1 µHz

Ramp/Tri. 1 µHz

Pulse 1 µHz

PRBS 1 µbps

Arbitrary 1 µSa/s

l Frequency Limitations: Changing functions may change the frequency to meet the new function's
frequency limits. Arbitrary waveforms retain their last frequency setting.

l Burst Limitation: For internally-triggered bursts, the minimum frequency is 126 µHz.

l Duty Cycle Limitations: For Square and Pulse, Duty Cycle on the 33500 Series is limited by the 16-ns
minimum pulse width specification. For example, at 1 kHz, Duty Cycle may be set as low as 0.01%,
because that would result in a pulse width of 100 ns. At 1 MHz, the minimum Duty Cycle is 1.6%, and
at 10 MHz it is 16%. Changing to a frequency that cannot produce the current duty cycle will adjust
the duty cycle to meet the minimum pulse width specification.

On the 33500 Series, the minimum pulse width is 16 ns. On the 33600 Series, the minimum pulse
width is 5 ns up to 4 Vpp and 8 ns up to 10 Vpp.

l Front Panel:

l SCPI: [SOURce[1|2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.
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Output Amplitude

The default amplitude is 100 mVpp (into 50 Ω) for all functions.

l Offset Voltage Limitations: The relationship between amplitude and offset is shown below. Vmax is ±5
V for a 50 Ω load or ±10 V for a high-impedance load.

Vpp < 2(Vmax – |Voffset|)

l Limits Due to Output Termination: If the amplitude is 10 Vpp and you change the output termination
setting from 50 Ω to "high impedance" (OUTPut[1|2]:LOAD INF), the displayed amplitude doubles to
20 Vpp. Changing from "high impedance" to 50 Ω halves the displayed amplitude. The output
termination setting does not affect the actual output voltage; it only changes the values displayed and
queried from the remote interface. Actual output voltage depends on the connected load.

l Limits Due to Units Selection: Amplitude limits are sometimes determined by the output units
selected. This may occur when the units are Vrms or dBm due to the differences in various functions'
crest factors.  For example, if you change a 5 Vrms square wave (into 50 Ω) to a sine wave, the
instrument will adjust the amplitude to 3.536 Vrms (the upper limit for sine in Vrms). The remote
interface will also generate a "Settings conflict" error.

l You can set the output amplitude in Vpp, Vrms, or dBm. You cannot specify output amplitude in dBm
if output termination is set to high impedance. See Output Units for details.

l Arbitrary Waveform Limitations: For arbitrary waveforms, amplitude is limited if the waveform data
points do not span the full range of the output DAC (Digital-to-Analog Converter). For example, the
built-in "Sinc" waveform does not use the full range of values, so its maximum amplitude is limited to
6.087 Vpp (into 50 Ω).

l Changing amplitude may briefly disrupt output at certain voltages due to output attenuator
switching. The amplitude is controlled, however, so the output voltage will never exceed the current
setting while switching ranges. To prevent this disruption, disable voltage autoranging using
VOLTage:RANGe:AUTO OFF. The APPLy command automatically enables autoranging.

l Setting the high and low levels also sets the waveform amplitude and offset. For example, if you set
the high level to +2 V and the low level to -3 V, the resulting amplitude is 5 Vpp, with a -500 mV
offset.

l A DC signal's output level is controlled by the offset voltage (DC Offset Voltage). The DC level may be
between ±5 V into a 50 Ω load or ±10 V with a high-impedance load.
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l Front Panel:

To use a high level and low level instead:

l SCPI:
[SOURce[1|2]:]VOLTage {<amplitude>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.
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DC Offset Voltage

The default offset is 0 V for all functions.

l Limits Due to Amplitude: The relationship between offset voltage and output amplitude is shown
below. The peak output voltage (DC plus AC) cannot exceed the instrument output rating (±5 V into
50 Ω load, or ±10 V into an open circuit).

l The relationship between offset voltage and output amplitude is shown below. Vmax is the maximum
peak voltage for the selected output termination (5 V for a 50 Ω load or 10 V for a high-impedance
load).

|Voffset| < Vmax - Vpp/2

If the specified offset voltage is not valid, the instrument will adjust it to the maximum DC voltage
allowed with the specified amplitude. From the remote interface, a "Data out of range" error will also
be generated.

l Limits Due to Output Termination: The offset range depends on the output termination setting. For
example, if you set offset to 100 mVDC and then change output termination from 50 Ω to "high
impedance," the offset voltage displayed on the front panel doubles to 200 mVDC (no error is
generated). If you change from "high impedance" to 50 Ω, the displayed offset voltage will be halved.
See OUTPut[1|2]:LOAD for details. Changing the output termination setting does not change the
voltage present at the output terminals of the instrument. This only changes the displayed values on
the front panel and the values queried from the remote interface. The voltage present at the
instrument's output depends on the load connected to the instrument. See OUTPut[1|2]:LOAD for
details.

l Arbitrary Waveform Limitations: For arbitrary waveforms, amplitude is limited if the waveform data
points do not span the full range of the output DAC (Digital-to-Analog Converter). For example, the
built-in "Sinc" waveform does not use the full range of values, so its maximum amplitude is limited to
6.087 Vpp (into 50 Ω).

l Setting the high and low levels also sets the waveform amplitude and offset. For example, if you set
the high level to +2 V and the low level to -3 V, the resulting amplitude is 5 Vpp, with a -500 mV
offset.

l To output a DC voltage level, select the DC voltage function (FUNCtion DC) and then set the offset
voltage (VOLTage:OFFSet). Valid values are between ±5 VDC into 50 Ω or ±10 VDC into an open
circuit. While the instrument is in DC mode, setting amplitude has no effect.

l Front Panel:
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l SCPI:
[SOURce[1|2]:]VOLTage:OFFSet {<offset>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

Output Units

Applies to output amplitude only.

l Output units: Vpp (default), Vrms, or dBm.

l Setting is volatile.

l Units selection applies to front panel and remote interface operations. For example, if you select
"VRMS" remotely, the units are displayed as "VRMS" on the front panel.

l Amplitude units cannot be dBm if output termination set to high impedance. Calculating dBm
requires finite load impedance. In this case, units are converted to Vpp.

l You can convert between units. For example, to convert 2 Vpp to Vrms equivalent:

The converted value is 707.1 mVrms for a sine wave.

l Front Panel:

l SCPI: [SOURce[1|2]:]VOLTage:UNIT {VPP|VRMS|DBM}

Operating Information

87 Keysight Trueform Series Operating and Service Guide



Output Termination

The instrument has a fixed series output impedance of 50 Ω to the front panel channel connectors. If the
actual load impedance differs from the value specified, the displayed amplitude and offset levels will be
incorrect. The load impedance setting is simply a convenience to ensure that the displayed voltage
matches the expected load.

l Output termination: 1 Ω to 10 kΩ, or infinite. The default is 50 Ω. The tab at the top of each channel
indicates the value of this setting.

l If you specify a 50 Ω termination but actually terminate into an open circuit, the output will be twice
the value specified. For example, if you set the DC offset to 100 mVDC (and specify a 50 Ω load) but
terminate into an open circuit, the actual offset will be 200 mVDC.

l Changing output termination setting, adjusts displayed output amplitude and offset (no error is
generated). If the amplitude is 10 Vpp and you change the output termination setting from 50 Ω to
"high impedance" (OUTPut[1|2]:LOAD INF), the displayed amplitude doubles to 20 Vpp. Changing
from "high impedance" to 50 Ω halves the displayed amplitude. The output termination setting does
not affect the actual output voltage; it only changes the values displayed and queried from the remote
interface. Actual output voltage depends on the connected load.

The output load can affect signal quality for pulse or other functions with high-speed
transitions. High load resistance can produce reflections.

l Units are converted to Vpp if output termination is high impedance.

l You cannot change output termination with voltage limits enabled, because instrument cannot know
which termination setting the limits apply to. Instead, disable voltage limits, set the new termination
value, adjust voltage limits, and re-enable voltage limits.

l Front Panel:

l SCPI: OUTPut[1|2]:LOAD {<ohms>|INFinity|MINimum|MAXimum|DEFault}

Keysight Trueform Series Operating and Service Guide 88

Operating Information



Duty Cycle (Square Waves)

A square wave’s duty cycle is the fraction of time per cycle that the waveform is at a high level (assuming
the waveform is not inverted). (See Pulse Waveforms for pulse duty cycle details.)

20% Duty Cycle 80% Duty Cycle

l Duty Cycle:0.01% to 99.99% at low frequencies; range reduced at higher frequency. Stored in volatile
memory; default 50%.

l This setting is remembered when you change to another function. A 50% duty cycle is always used for
a modulating square waveform; the duty cycle setting applies only to a square wave carrier.

l Front Panel:

If you use the keypad, press Percent to finish:

l SCPI: [SOURce[1|2]:]FUNCtion:SQUare:DCYCle {<percent>|MINimum|MAXimum}

The APPLy command sets the duty cycle to 50%.
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Symmetry (Ramp Waves)

Applies to ramp waves only. Symmetry represents the fraction of each cycle that the ramp wave is rising
(assuming waveform is not inverted).

0% Symmetry 100% Symmetry

l The symmetry (default 100%) is stored in volatile memory; and is remembered when you change to
and from other waveforms.

l When ramp is the modulating waveform for AM, FM, PM, or PWM, the symmetry setting does not
apply.

l Front Panel:

Then choose one of the following options. The Symmetry option allows you to use the knob or
keypad to specify a value.

If you use the keypad, press Percent to finish:

l SCPI: [SOURce[1|2]:]FUNCtion:RAMP:SYMMetry {<percent>|MINimum|MAXimum|DEFault}

The APPLy command sets the symmetry to 100%.
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Voltage Autoranging

Autoranging is enabled by default and the instrument selects optimal attenuator settings. With
autoranging disabled, the instrument uses the current attenuator settings and does not switch attenuator
relays.

l You can disable autoranging to eliminate momentary disruptions caused by attenuator switching
while changing amplitude. However:

l The amplitude and offset accuracy and resolution (and waveform fidelity) may be adversely affected
when reducing the amplitude below a range change that would occur with autoranging on.

l You may not achieve minimum amplitude with autoranging on.

l Some instrument specifications do not apply with autoranging off.

l Front Panel:

or

l SCPI: [SOURce[1|2]:]VOLTage:RANGe:AUTO {OFF|0|ON|1|ONCE}

The APPLy command always enables autoranging.
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Output Control

By default, channel output is disabled at power on to protect other equipment. To enable a channel's
output, see below. When channel output is enabled, the corresponding channel button is lit.

l If an external circuit applies excessive voltage to a channel output connector, the instrument
generates an error message and disables the output. To re-enable output, remove the overload and
turn the channel on again.

l Front Panel:

l SCPI: OUTPut[1|2] {ON|1|OFF|0}

The APPLy command always enables the channel output connector.
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Waveform Polarity

In normal mode (default), the waveform goes positive at the beginning of the cycle. Inverted mode does
the opposite.

l As shown below, the waveform is inverted relative to the offset voltage. The offset voltage remains
unchanged when the waveform is inverted.

No Offset Voltage With Offset Voltage

l The Sync signal associated with an inverted waveform is not inverted.

l Front Panel:

or

l SCPI: OUTPut[1|2]:POLarity {NORMal|INVerted}
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Sync Output Signal

A sync output is provided on the front panel Sync connector. All of the standard output functions (except
DC and noise) have an associated Sync signal. For applications where you may not want to output the
Sync signal, you can disable the Sync connector. The Sync signal may be derived from either output
channel in a two-channel instrument.

General Behavior

l By default, the Sync signal is derived from channel 1 and is routed to the Sync connector (enabled).

l When the Sync signal is disabled, the output level on the Sync connector is at a logic "low."

l The polarity of the Sync signal is specified by OUTPut:SYNC:POLarity {INVerted|NORMal}.

l Inverting a waveform (see Waveform Polarity), does not invert the associated Sync signal .

l For sine, pulse, ramp, square, and triangle waves, the Sync signal is a square wave that is "high" in the
first half of the cycle and "low" in the last half. The Sync signal’s voltages are TTL-compatible when its
load impedance exceeds 1 kΩ.

l For arbitrary waveforms, the Sync signal rises at the beginning of the waveform and falls at the middle
of the arbitrary waveform. You can override this default behavior by using MARKer:POINt to specify
the point within the arbitrary waveform at which the Sync signal transitions to "low."

Modulation

l For internally-modulated AM, FM, PM, and PWM, the Sync signal is normally referenced to the
modulating waveform (not the carrier) and is a square waveform with a 50% duty cycle. The Sync
signal is a TTL "high" during the first half of the modulating waveform. You can set up the Sync signal
to follow the carrier waveform by using the command OUTPut:SYNC:MODE
{CARRier|NORMal|MARKer} when modulating with internal modulation.

l For externally-modulated AM, FM, PM, and PWM, the Sync signal is referenced to the carrier
waveform (not the modulating waveform) and is a square waveform with a 50% duty cycle.

l You can override normal sync behavior to force Sync to always follow the carrier waveform (OUTPut
[1|2]:SYNC:MODE CARRier).

l For FSK, the Sync signal is referenced to the FSK rate. The Sync signal is a TTL "high" on the transition
to the "hop" frequency.

Sweep

l The Sync signal is a TTL "high" at the beginning of the sweep and goes "low" at the sweep's midpoint.
The Sync signal is synchronized with the sweep, but is not equal to the sweep time because its timing
includes the re-arm time.

l For frequency sweeps with Marker On, the Sync signal is a TTL "high" at the beginning of the sweep
and a "low" at the marker frequency. You can change this with OUTPut[1|2]:SYNC:MODE MARKER.
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Burst

l For a triggered burst, the Sync signal is a TTL "high" when the burst begins. The Sync signal is a TTL
"low" at the end of the specified number of cycles (may not be the zero-crossing point if the waveform
has an associated start phase). For an infinite count burst, the Sync signal is the same as for a
continuous waveform.

l For an externally-gated burst, the Sync signal follows the external gate signal. However, the signal
will not go "low" until the end of the last cycle (may not be a zero-crossing if the waveform has an
associated start phase).

Configuring Sync Output

l Front Panel:
To toggle Sync off and on:

To configure Sync:

l SCPI:
OUTPut:SYNC {ON|1|OFF|0}

OUTPut[1|2]:SYNC:MODE {NORMal|CARRier|MARKer}

OUTPut[1|2]:SYNC:POLarity {NORMal|INVerted}

OUTPut:SYNC:SOURce {CH1|CH2}

Pulse Waveforms

As shown below, a pulse or square wave consists of a period, a pulse width, a rising edge, and a falling
edge.
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Period

l Period: reciprocal of maximum frequency to 1,000,000 s. The default is 1 ms.

l The instrument adjusts the pulse width and edge time as needed to accommodate the specified
period.

l Front Panel:

Select Pulse waveform:

Select period instead of frequency:

Set the period:

l SCPI: [SOURce[1|2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}
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Pulse Width

Pulse width is the time from the 50% threshold of a pulse's rising edge to the 50% threshold of the next
falling edge.

l Pulse width: up to 1,000,000 s (see restrictions below). The default pulse width is 100 μs. The
minimum pulse width is 16 ns on the 33500 Series and 5 ns up to 4 Vpp or 8 ns up to 10 Vpp on the
33600 Series.

l The specified pulse width must also be less than the difference between the period and the minimum
pulse width.

l The instrument will adjust the pulse width to accommodate the specified period.

l Front Panel:

l SCPI: [SOURce[1|2]:]FUNCtion:PULSe:WIDTh {<seconds>|MINimum|MAXimum|DEFault}
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Pulse Duty Cycle

The pulse duty cycle is defined as follows:

Duty Cycle = 100(Pulse Width)/Period

Pulse width is the time from the 50% threshold of a pulse's rising edge to the 50% threshold of the next
falling edge.

l Pulse duty cycle: 0.01% to 99.99% (see restrictions below). The default is 10%.

l The pulse duty cycle must conform to the following restrictions determined by the minimum pulse
width (Wmin). The instrument will adjust the pulse duty cycle to accommodate the specified period.

Duty Cycle > 100(Minimum Pulse Width) / Period

and

Duty Cycle < 100(1 – (Minimum Pulse Width/ Period))

The minimum pulse width is 16 ns on the 33500 Series and 5 ns up to 4 Vpp or 8 ns up to 10 Vpp on
the 33600 Series.

l The longer the edges, the greater the minimum pulse width. Longer edges will therefore restrict duty
cycle more than shorter edges.

l Front Panel:

Select pulse function:

Toggle to Duty Cycle:

Enter the Duty Cycle:
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l SCPI: [SOURce[1|2]:]FUNCtion:PULSe:DCYCle {<percent>|MINimum|MAXimum|DEFault}

Edge Times

The edge times set the transition times for the leading and trailing edges of the pulse, either independently
or together. The edge time represents the time between the 10% and 90% thresholds.

l Edge time: Minimum of 8.4 ns on the 33500 Series, and 2.9 ns up to 4 Vpp, or 3.3 ns up to 10 Vpp on
the 33600 Series. Maximum of 1 μs and default 10 ns.

l The specified edge time must fit within the specified pulse width as shown above. The instrument will
adjust the edge time to accommodate the specified pulse width.

l Front Panel:

l SCPI:
[SOURce[1|2]:]FUNCtion:PULSe:TRANsition:LEADing {<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]FUNCtion:PULSe:TRANsition:TRAiling {<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]FUNCtion:PULSe:TRANsition[:BOTH] {<seconds>|MINimum|MAXimum|DEFault}

Amplitude Modulation (AM) and Frequency Modulation (FM)

A modulated waveform consists of a carrier waveform and a modulating waveform. In AM, the carrier
amplitude is varied by the voltage level of the modulating waveform. In FM, the carrier frequency is varied
by the voltage level of the modulating waveform. The instrument accepts an internal or external
modulation source. On a two-channel instrument, one channel can modulate the other.

Select AM or FM before setting up any other modulation parameter. For more information on modulation,
see Modulation.

To Select AM or FM

l The instrument allows only one modulation mode to be enabled on a channel. When you enable AM
or FM, all other modulations are off. On two-channel models, the two channels’ modulations are
independent from one another, and the instrument can add modulated waveforms from two
channels. See PHASe:SYNChronize and COMBine:FEED for details.
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l The instrument will not allow AM or FM to be enabled with sweep or burst. Enabling AM or FM, turns
off sweep and burst.

l To avoid multiple waveform changes, enable modulation after configuring the other modulation
parameters.

l Front Panel:

or

Then turn modulation on:

The waveform is output using the present carrier and modulating waveform settings.

l SCPI:
[SOURce[1|2]:]AM:STATe{ON|1|OFF|0}

[SOURce[1|2]:]FM:STATe {ON|1|OFF|0}

Carrier Waveform Shape

l AM or FM carrier shape: Sine (default), Square, Ramp, Pulse, Triangle, Noise (AM only), PRBS, or
Arbitrary waveform. You cannot use DC as the carrier waveform.

l For FM, the carrier frequency must always be greater than or equal to the frequency deviation.
Attempting to set a deviation greater than the carrier frequency will cause the instrument to set the
deviation equal to the carrier frequency.

l The carrier frequency plus the deviation cannot exceed the selected function's maximum frequency
plus 100 kHz. If you attempt to set the deviation to an invalid value, the instrument adjusts it to the
maximum value allowed with the present carrier frequency. The remote interface also generates a
"Data out of range" error.
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l Front Panel:

Then select a waveform shape.

l SCPI:
[SOURce[1|2]:]FUNCtion <function>

The APPLy command configures a waveform with one command.

Carrier Frequency

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default
is 1 kHz for all functions other than arbitrary waveforms. Arbitrary waveform "frequency" is also set using
the FUNCtion:ARBitrary:SRATe command.

l Front Panel:

l SCPI: [SOURce[1|2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.
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Modulating Waveform Shape

The instrument accepts an internal or external AM or FM modulation source. On a two-channel
instrument you can modulate one channel with the other.

You cannot modulate noise with noise, PRBS with PRBS, or an arbitrary waveform with an
arbitrary waveform.

l The modulating waveform shape (internal source) may be:

l Sine wave

l Square with 50% duty cycle  

l UpRamp with 100% symmetry  

l Triangle with 50% symmetry  

l DnRamp with 0% symmetry  

l Noise - white gaussian noise

l PRBS - Pseudo Random Bit Sequence (polynomial PN7)

l Arb - Arbitrary waveform

l Front Panel:

or

Then choose the modulating shape:

l SCPI:
[SOURce[1|2]:]AM:INTernal:FUNCtion <function>

[SOURce[1|2]:]FM:INTernal:FUNCtion <function>
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Modulating Waveform Frequency

The instrument accepts an internal or external modulation source.

l Modulating frequency (internal source): minimum is 1 µHz, and the maximum values vary by model,
function, and output, as shown here.

l Modulating frequency (external source): 0 to 100 kHz

l Front Panel:

(33500 Series only)

or

Then enter the AM or FM frequency with the knob and keypad:

l SCPI:
[SOURce[1|2]:]AM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]FM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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Modulation Depth (AM)

The modulation depth is a percentage that represents the amplitude variation. At 0% depth, the amplitude
is one-half of the carrier’s amplitude setting. At 100% depth, the amplitude varies according to the
modulating waveform, from 0% to 100% of the carrier’s amplitude.

l Modulation depth: 0% to 120%. The default is 100%.

l Even at greater than 100% depth, the instrument will not exceed ±5 V peak on the output (into a 50 Ω
load). To achieve modulation depth greater than 100%, output carrier amplitude may be reduced.

l Front Panel:

l SCPI: [SOURce[1|2]:]AM[:DEPTh] {<depth_in_percent>|MINimum|MAXimum}

Double Sideband Suppressed Carrier AM

The instrument supports two forms of amplitude modulation, "Normal" and Double Sideband Suppressed
Carrier (DSSC). In DSSC, the carrier is not present unless the modulating signal has an amplitude greater
than zero.

l Front Panel:

l SCPI: [SOURce[1|2]:]AM:DSSC{ON|1|OFF|0}.
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Frequency Deviation (FM)

The frequency deviation setting represents the peak variation in frequency of the modulated waveform
from the carrier frequency.

When the carrier is PRBS, frequency deviation causes a change in the bit rate equal to one-half of the set
frequency. For example, a 10 kHz deviation is equivalent to a 5 KBPS change in bit rate.

l Frequency deviation: 1 µHz to (carrier frequency)/2, default 100 Hz.

l For FM, the carrier frequency must always be greater than or equal to the frequency deviation.
Attempting to set a deviation greater than the carrier frequency will cause the instrument to set the
deviation equal to the carrier frequency.

l The carrier frequency plus the deviation cannot exceed the selected function's maximum frequency
plus 100 kHz. If you attempt to set the deviation to an invalid value, the instrument adjusts it to the
maximum value allowed with the present carrier frequency. The remote interface also generates a
"Data out of range" error.

l Front Panel:

l SCPI: [SOURce[1|2]:]FM[:DEViation] {<peak_deviation_in_Hz>|MINimum|MAXimum|DEFault}
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Modulating Source

The instrument accepts an internal or external modulation source. On a two-channel instrument you can
modulate one channel with the other.

On the 33600 Series, you can configure the modulation source to accept either a ±5 V signal
or a ±1 V signal. See INPut:ATTenuation[:STATe] for details.

l Modulating source: Internal (default), Other Channel, or External. The External modulation source
may be up to 100 kHz.

l With the External source, an external waveform modulates the carrier waveform. The modulation
depth (AM) or frequency deviation (FM) is controlled by the signal level on the rear-panel Modulation
In connector. The external modulation input has -3 dB bandwidth of 100 kHz.

l AM example: with modulation depth 100%, when the modulating signal is at +5 V, the output will be
at the maximum amplitude. When the modulating signal at -5 V, the output will be at minimum
amplitude.

l FM example: with deviation of 10 kHz, then a +5 V signal level corresponds to a 10 kHz increase in
frequency. Lower external signal levels produce less deviation and negative signal levels reduce the
frequency below the carrier frequency.

l Front Panel:
After enabling AM or FM, select the modulating source as shown:

l SCPI:
[SOURce[1|2]:]AM:SOURce {INTernal|EXTernal|CH1|CH2}

[SOURce[1|2]:]FM:SOURce {INTernal|EXTernal|CH1|CH2}

Phase Modulation (PM)

A modulated waveform consists of a carrier waveform and a modulating waveform. PM is very similar to
FM, but in PM the phase of the modulated waveform is varied by the instantaneous voltage of the
modulating waveform.

For more information on the fundamentals of Phase Modulation, see Tutorial - Modulation.

To Select Phase Modulation

l Only one modulation mode may be enabled at a time. Enabling PM disables the previous modulation
mode.

l Enabling PM turns off sweep and burst.
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l Front Panel:

The waveform is output using the present carrier and modulating waveform settings.

l To avoid multiple waveform changes, enable modulation after configuring the other modulation
parameters.

l SCPI: [SOURce[1|2]:]PM:STATe {ON|1|OFF|0}

Carrier Waveform Shape

l PM carrier shape: Sine (default), Square, Ramp, Triangle, Pulse, PRBS, or Arbitrary. You cannot use
Noise or DC as the carrier waveform.

l Front Panel:

Then select any waveform except Noise or DC.

l SCPI: [SOURce[1|2]:]FUNCtion <function>

l The APPLy command configures a waveform with one command.

l When the carrier is an arbitrary waveform, modulation affects the sample "clock" instead of the full
cycle defined by the arbitrary waveform sample set. Because of this, applying phase modulation to
arbitrary waveforms is limited.
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Carrier Frequency

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default
is 1 kHz for all functions other than arbitrary waveforms. Carrier frequency must be greater than 20 times
the peak modulation frequency.

l Front Panel:

or or any other Frequency key.

After selecting the frequency key:

l SCPI: [SOURce[1|2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

l The APPLy command configures a waveform with one command.
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Modulating Waveform Shape

The instrument accepts an internal or external modulation source.

l The modulating waveform shape (internal source) may be:

l Sine wave

l Square with 50% duty cycle  

l UpRamp with 100% symmetry  

l Triangle with 50% symmetry  

l DnRamp with 0% symmetry  

l Noise - white gaussian noise

l PRBS - Pseudo Random Bit Sequence (polynomial PN7)

l Arbitrary waveform

l You can use noise as the modulating waveshape, but you cannot use noise or DC as the carrier
waveform.

l Front Panel:

l SCPI: [SOURce[1|2]:]PM:INTernal:FUNCtion <function>
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Modulating Waveform Frequency

The instrument accepts an internal or external modulation source. The external modulation input has a -
3dB bandwidth of 100 kHz.

l Modulating frequency (internal): default 10 Hz, minimum 1 µHz; maximum varies by model, function,
and output voltage, as shown here.

l Front Panel:

Then set the modulating waveform frequency:

l SCPI: [SOURce[1|2]:]PM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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Phase Deviation

The phase deviation setting represents the peak variation in phase of the modulated waveform from the
carrier waveform. The phase deviation can be set from 0 to 360 degrees (default 180).

l Front Panel:

Then set the phase deviation:

l SCPI: [SOURce[1|2]:]PM:DEViation {<deviation in degrees>|MINimum|MAXimum|DEFault}

l When the carrier is an arbitrary waveform, the deviation applies to the sample clock. Therefore, the
effect on the full arbitrary waveform is much less than that seen with standard waveforms. The extent
of the reduction depends on the number of points in the arbitrary waveform.

Modulating Source

The instrument accepts an internal or external modulation source.

l Modulating source: Internal (default), Other Channel, or External. The External modulation source
may be up to 100 kHz.

l With the External source, the carrier waveform is modulated with an external waveform. The ±5 V
signal level present on the rear-panel Modulation In connector controls the phase deviation. For
example, if the deviation is set to 180 degrees, a +5 V signal corresponds to a 180 degree phase shift.
Lower levels produce less deviation.

l Front Panel:

l SCPI: [SOURce[1|2]:]PM:SOURce {INTernal|EXTernal|CH1|CH2}
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Frequency-Shift Keying (FSK) Modulation

You can configure the instrument to "shift" its output frequency between two preset values (called the
"carrier frequency" and the "hop frequency") using FSK modulation. The rate at which the output shifts
between these two frequencies is determined by the internal rate generator or the signal level on the rear-
panel Ext Trig connector.

See Front Panel Menu Operation - Output an FSK Waveform for details on FSK using the front panel.

To Select FSK Modulation

FSKey:STATe {OFF|ON}

l Only one modulation mode may be enabled at a time. Enabling FSK turns off the previous modulation
mode.

l You cannot enable FSK when sweep or burst is enabled. Enabling FSK turns off sweep and burst.

l To avoid multiple waveform changes, enable modulation after configuring the other modulation
parameters.

FSK Carrier Frequency

[SOURce[1|2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default
is 1 kHz for all functions other than arbitrary waveforms.

l When the External source is selected, the output frequency is determined by the signal level on the
rear-panel Ext Trig connector. When a logic low is present, the carrier frequency is output. With a
logic high, the hop frequency is output.

FSK "Hop" Frequency

[SOURce[1|2]:]FSKey:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The maximum alternate ("hop") frequency depends on the function. The default is 100 Hz for all functions.
The internal modulating waveform is a 50% duty cycle square wave.

Function Minimum Hop Frequency Maximum Hop Frequency

Sine 1 µHz (varies by model, as shown here)

Square

Ramp/Triangle

Pulse

l When the External source is selected, the output frequency is determined by the signal level on the
rear-panel Ext Trig connector. When a logic low is present, the carrier frequency is output. With a
logic high, the hop frequency is output.
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FSK Rate

[SOURce[1|2]:]FSKey:INTernal:RATE {<rate_in_Hz>|MINimum|MAXimum}

The FSK rate is the rate at which the output frequency "shifts" between the carrier frequency and the hop
frequency using the internal FSK source.

l FSK rate (internal source): 125 µHz (33500 Series) or 250 µHz (33600 Series) up to 1 MHz, default 10
Hz.

l The FSK rate is ignored when the external FSK source is selected.

FSK Source

[SOURce[1|2]:]FSKey:SOURce {INTernal|EXTernal}

May be Internal (default) or External.

l When the Internal source is selected, the rate at which the output frequency "shifts" between the
carrier frequency and hop frequency is determined by the FSK rate. The internal modulating waveform
is a 50% duty cycle square wave.

l When the External source is selected, the output frequency is determined by the signal level on the
rear-panel Ext Trig connector. When a logic low is present, the carrier frequency is output. With a
logic high, the hop frequency is output.

l The connector used for externally-controlled FSK waveforms (Ext Trig) is not the same connector that
is used for externally-modulated AM, FM, PM, and PWM waveforms (Modulation In). When used for
FSK, the Ext Trig connector does not have adjustable edge polarity.

Pulse Width Modulation (PWM)

This section discusses PWM, which stands for pulse-width modulation. PWM is only available for the Pulse
waveform, and the pulse width varies according to the modulating signal. The amount by which the pulse
width varies is called the width deviation, and it can be specified as a percentage of the waveform period
(that is, duty cycle) or in units of time. For example, if you specify a pulse with 20% duty cycle and then
enable PWM with a 5% deviation, the duty cycle varies from 15% to 25% under control of the modulating
signal.

The instrument accepts an internal or external modulation source.
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To Select PWM

l You cannot enable PWM when sweep or burst is enabled.

l To avoid multiple waveform changes, enable modulation after configuring the other modulation
parameters.

l Front Panel:

The waveform is output using the present carrier and modulating waveform settings.

l SCPI: [SOURce[1|2]:]PWM:STATe {ON|1|OFF|0}
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Modulating Waveform Shape

The instrument accepts an internal or external modulation source.

l The modulating waveform shape (internal source) may be:

l Sine wave

l Square with 50% duty cycle  

l UpRamp with 100% symmetry  

l Triangle with 50% symmetry  

l DnRamp with 0% symmetry  

l Noise - white gaussian noise

l PRBS - Pseudo Random Bit Sequence (polynomial PN7)

l Arbitrary waveform

l Front Panel:

l SCPI: [SOURce[1|2]:]PWM:INTernal:FUNCtion <function>
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Modulating Waveform Frequency

The instrument accepts an internal or external modulation source. The external modulation input has a -3
dB bandwidth of 100 kHz.

l Modulating frequency (internal source): The default is 10 Hz, and the minimum is 1 µHz. The maximum
frequency varies by function, model, and output voltage, as shown here.

l Front Panel:

l SCPI: [SOURce[1|2]:]PWM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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Width or Duty Cycle Deviation

The PWM deviation setting is the peak variation in width of the modulated pulse waveform. You can set it
in units of time or duty cycle.

l Front Panel:

To set deviation in terms of duty cycle:

l SCPI: [SOURce[1|2]:]PWM:DEViation {<deviation>|MINimum|MAXimum|DEFault}

l The sum of the pulse width and deviation must satisfy the formula:

Pulse Width + Deviation < Period – 16 ns (33500 Series)

Pulse Width + Deviation < Period – 8 ns (33600 Series above 4 Vpp)

Pulse Width + Deviation < Period – 5 ns (33600 Series up to and including 4 Vpp)

l If necessary, the instrument will adjust the deviation to accommodate the specified period.
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Modulating Source

The instrument accepts an internal or external modulation source.

l Modulating source: Internal (default), Other Channel, or External. The External modulation source
may be up to 100 kHz.

l If you select the External modulating source, the deviation is controlled by the ±5 V signal level
(optionally ±1 V on the 33600 Series) on the rear-panel Modulation In connector. For example, if you
have set the deviation to 1 µs, then a +5 V signal (optionally + 1 V on the 33600 Series) corresponds to
a 1 µs increase in width. Lower signal levels produce less deviation.

l Front Panel:

l SCPI: [SOURce[1|2]:]PWM:SOURce {INTernal|EXTernal|CH1|CH2}

Pulse Waveform

l Pulse is the only waveform shape supported for PWM.

l Front Panel:

l SCPI: FUNCtion PULSe

l The APPLy command configures a waveform with one command.
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Pulse Period

The range for the pulse period is from the reciprocal of the instrument's maximum frequency up to
1,000,000 s (default 100 µs). Note that the waveform period limits the maximum deviation.

l Front Panel:

l SCPI: [SOURce[1|2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Sum Modulation

Sum modulation adds a modulating signal to any carrier waveform; it is typically used to add gaussian
noise to a carrier. The modulating signal is added to the carrier as a percentage of carrier waveform
amplitude.

Enable Sum

l To avoid multiple waveform changes, enable Sum after configuring other modulation parameters.

l Front Panel:

l SCPI: [SOURce[1|2]:]SUM:STATe {ON|1|OFF|0}
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Modulating Waveform Shape

The instrument accepts an internal or external modulation source. On a two-channel instrument you can
modulate one channel with the other.

l The modulating waveform shape (internal source) may be:

l Sine wave

l Square with 50% duty cycle  

l UpRamp with 100% symmetry  

l Triangle with 50% symmetry  

l DnRamp with 0% symmetry  

l Noise

l PRBS with PN7 sequence

l Arbitrary waveform

l Front Panel:

l SCPI: [SOURce[1|2]:]SUM:INTernal:FUNCtion <function>

Modulating Waveform Frequency

The instrument accepts an internal or external modulation source. On a two-channel instrument you can
modulate one channel with the other.

l Modulating frequency (internal source): The default 100 Hz and the minimum is 1 µHz. The maximum
frequency varies by function, model, and output voltage, as shown here.

l Front Panel:

l SCPI: [SOURce[1|2]:]SUM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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Sum Amplitude

The Sum Amplitude represents the amplitude of the signal added to the carrier (in percent of carrier
amplitude).

l Amplitude setting: 0 to 100% of carrier amplitude, 0.01% resolution.

l Sum Amplitude remains a constant fraction of carrier amplitude and tracks carrier amplitude changes.

l Front Panel:

l SCPI: [SOURce[1|2]:]SUM:AMPLitude {<amplitude>|MINimum|MAXimum|DEFault}
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Modulating Source

The instrument accepts an internal or external modulation source. On a two-channel instrument you can
modulate one channel with the other.

l Modulating source: Internal (default), Other Channel, or External. The External modulation source
may be up to 100 kHz.

l With the external source, the carrier waveform is summed by the ±5 V signal level (optionally ±1 V on
the 33600 Series) on the rear-panel Modulation In connector. For example, if you have set the sum
amplitude to 10%, then when the modulating signal is at +5 V (optionally +1 V on the 33600 Series),
the output will be at the maximum amplitude (110% of carrier amplitude). When the modulating
signal is at -5 V (optionally -1 V on the 33600 Series), the output will be at the minimum amplitude
(90% of carrier amplitude).

If you are using the other channel as the source for SUMmodulation, consider using the
Combine feature instead. The Combine feature has fewer restrictions and less delay than
SUM with other channel.

l Front Panel:

l SCPI: [SOURce[1|2]:]SUM:SOURce {INTernal|EXTernal|CH1|CH2}

Frequency Sweep

In frequency sweep mode, the instrument moves from the start frequency to the stop frequency at a
specified sweep rate. You can sweep up or down in frequency, with either linear or logarithmic spacing.
You can also configure the instrument to output one sweep from start frequency to stop frequency by
applying an external or manual trigger. The instrument can sweep sine, square, pulse, ramp, triangle, or
arbitrary waveforms (PRBS, noise and DC are not allowed).

You can specify a hold time, during which the sweep remains at the stop frequency, and a return time,
during which the frequency changes linearly from the stop frequency to the start frequency.

For more information, see Frequency Sweep.

To Select Sweep

The instrument will not allow sweep or list mode to be enabled at the same time that burst or any
modulation mode is enabled. When you enable sweep, the burst or modulation mode is turned off.
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l To avoid multiple waveform changes, enable the sweep mode after configuring the other parameters.

l Front Panel:

l SCPI:
[SOURce[1|2]:]FREQuency:MODE SWEEP

[SOURce[1|2]:]SWEep:STATe {ON|1|OFF|0}
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Start Frequency and Stop Frequency

The start frequency and stop frequency set the sweep’s upper and lower frequency bounds. The sweep
begins at the start frequency, sweeps to the stop frequency, and then resets back to the start frequency.

l Start and Stop frequencies: 1 µHz to maximum frequency for the waveform. The sweep is phase
continuous over the full frequency range. The default start frequency is 100 Hz. The default stop
frequency is 1 kHz.

l To sweep up in frequency, set the start frequency less than the stop frequency. To sweep down in
frequency, set the opposite relationship.

l Sync setting Normal: Sync pulse is high throughout the sweep.

l Sync setting Carrier: Sync pulse has a 50% duty cycle for every waveform cycle.

l Sync setting Marker: Sync pulse goes high at the beginning and goes low at the marker frequency.
You can change this with OUTPut[1|2]:SYNC:MODE MARKER.

l Front Panel:

l SCPI:
[SOURce[1|2]:]FREQuency:STARt {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]FREQuency:STOP {<frequency>|MINimum|MAXimum|DEFault}
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Center Frequency and Frequency Span

You can also set the sweep frequency boundaries of the sweep using a center frequency and frequency
span. These parameters are similar to the start frequency and stop frequency (above) and they provide
added flexibility.

l Center frequency: 1 µHz to maximum frequency for the waveform. The default is 550 Hz.

l Frequency span: Any value between ±maximum frequency for the waveform. The default is 900 Hz.

l To sweep up in frequency, set a positive frequency span; to sweep down, set a negative frequency
span.

l Sync setting Normal: Sync pulse is high throughout the sweep.

l Sync setting Carrier: Sync pulse has a 50% duty cycle for every waveform cycle.

l Sync setting Marker: Sync pulse goes high at the beginning and goes low at the marker frequency.
You can change this with OUTPut[1|2]:SYNC:MODE MARKER.

l Front Panel:

l SCPI:
[SOURce[1|2]:]FREQuency:CENTer {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]FREQuency:SPAN {<frequency>|MINimum|MAXimum|DEFault}
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Sweep Mode

You can sweep with linear or logarithmic spacing, or with a list of sweep frequencies. For a linear sweep,
the instrument varies the output frequency linearly during the sweep. A logarithmic sweep varies the
output frequency logarithmically.

The selected mode does not affect the sweep return (from stop to start, if one is set). The sweep return is
always linear.

l Front Panel:

l SCPI: [SOURce[1|2]:]SWEep:SPACing {LINear|LOGarithmic}

Sweep Time

Sweep time specifies the number of seconds required to sweep from the start frequency to the stop
frequency. The instrument calculates the number of points in the sweep based on the sweep time.

l Sweep time: 1 ms to 250,000 seconds, default 1 s. For a linear sweep in immediate trigger mode, the
maximum total sweep time (including hold time and return time) is 8,000 s. The maximum total sweep
time for linear sweeps using other trigger modes is 250,000 s; the maximum total sweep time for
logarithmic sweeps is 500 s.

l Front Panel:

l SCPI: [SOURce[1|2]:]SWEep:TIME {<seconds>|MINimum|MAXimum|DEFault}
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Hold/Return Time

Hold time specifies time (in seconds) to remain at the stop frequency, and return time specifies the number
of seconds to return from the stop frequency to the start frequency.

l Hold time and return time: 0 to 3600 seconds (default 0).

l Front Panel:

l SCPI:
[SOURce[1|2]:]SWEep:HTIMe {<hold_time>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]SWEep:RTIMe {<return_time>|MINimum|MAXimum|DEFault}
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Marker Frequency

If desired, you can set the frequency at which the signal on the front panel Sync connector goes to a logic
low during the sweep. The Sync signal always goes from low to high at the beginning of the sweep.

l Marker frequency: 1 µHz to maximum frequency for the waveform. The default is 500 Hz.

l When the sweep mode is enabled, the marker frequency must be between the specified start
frequency and stop frequency. If you attempt to set the marker frequency to a frequency not in this
range, the instrument will set the marker frequency equal to the start frequency or stop frequency
(whichever is closer).

l You cannot configure the marker frequency with the front panel menus unless the Sync source is the
sweeping channel.

l Front Panel:

l SCPI: [SOURce[1|2]:]MARKer:FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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Sweep Trigger Source

In sweep mode, the instrument outputs a single sweep when a trigger signal is received. After one sweep
from the start frequency to the stop frequency, the instrument waits for the next trigger while outputting
the start frequency.

l Sweep trigger source: Immediate (default), External, Time, or Manual.

l With the Immediate (internal) source, the instrument outputs a continuous sweep at a rate determined
by the total of the hold time, sweep time and return time. The sweep time for this source is limited to
8000 seconds.

l With the External source, the instrument accepts a hardware trigger on the rear-panel Ext Trig
connector and initiates one sweep each time Ext Trig receives a TTL pulse with the specified polarity.

l The trigger period must be greater than or equal to the specified sweep time.

l With the Manual source, the instrument outputs one sweep each time the front panel [Trigger] key is
pressed.

l Front Panel:

l To specify the slope of the trigger signal edge:

l SCPI:
TRIGger[1|2]:SOURce {IMMediate|EXTernal|TIMer|BUS}

TRIGger[1|2]:SLOPe {POSitive|NEGative}

See Triggering for more information.
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Trigger Out Signal

A "trigger out" signal is provided on the rear-panel Ext Trig connector (used with burst and sweep only).
When enabled, a pulse with either a rising edge (default) or falling edge is output from this connector at
the beginning of the sweep or burst.

l When the Immediate (internal) trigger source is selected, the instrument outputs a square waveform
with a 50% duty cycle from the Ext Trig connector at the beginning of the sweep or burst. The
frequency of the waveform corresponds to the specified burst period or total sweep time.

l When the External trigger source is selected, the instrument disables the "trigger out" signal. The Ext
Trig connector cannot be used for sweep or burst and trigger out at the same time (an externally-
triggered waveform uses the same connector to trigger the sweep or burst).

l When Manual or bus (software) trigger source is selected, the instrument outputs a pulse (>1 μs pulse
width on the 33500 Series and 100 ns on the 33600 Series) from the Ext Trig connector at the
beginning of each sweep or burst.

l To specify whether the instrument triggers on the rising or falling edge on the Ext Trig connector,
press [Trigger] > Trig Out Setup. Then select the desired edge by pressing Trig Out.

l SCPI:
OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF|0}

Frequency List

In frequency list mode, the instrument "steps" through a list of frequencies, dwelling on each frequency
for a specified period. You may also control progress through the list with triggering.

l The instrument will not allow sweep or list mode to be enabled at the same time that burst or any
modulation mode is enabled. When you enable sweep, the burst or modulation mode is turned off.

l To avoid multiple waveform changes, enable list mode after configuring its parameters.

l Front Panel: Enable list before setting any other list parameter. Press [Sweep] > Type > List.

l SCPI:
[SOURcd[1|2]:]FREQuency:MODE LIST

[SOURce[1|2]:]LIST:FREQuency <freq1>[, <freq2>, etc.]

l Progress through list is controlled by the trigger system. If trigger source is internal or immediate, the
dwell time setting (LIST:DWELl) determines time spent at each frequency. For any other trigger
source, dwell time is determined by trigger event spacing.

Burst Mode

The instrument can output a waveform for a specified number of cycles, called a burst. Burst is allowed
with sine, square, triangle, ramp, pulse, PRBS, or arbitrary waveforms (noise is allowed only in gated burst
mode; DC is not allowed).
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For details, see Tutorial - Burst.

To Select Burst

Burst cannot be enabled when sweep or modulation is enabled. Enabling burst turns off sweep and
modulation.

l To avoid multiple waveform changes, enable burst mode after configuring other parameters.

l Front Panel:

l SCPI: [SOURce[1|2]:]BURSt:STATe {ON|1|OFF|0}
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Burst Mode

Burst has two modes, described below. Selected mode controls allowable trigger source, and which other
burst parameters apply.

l Triggered Burst Mode (default): The instrument outputs a waveform for specified number of cycles
(burst count) each time trigger is received. After outputting specified number of cycles, instrument
stops and waits for next trigger. The instrument can use an internal trigger to initiate burst, or you can
provide external trigger by pressing the front panel [Trigger] key, applying trigger signal to rear-panel
Ext Trig connector, or sending software trigger command from remote interface.

l External Gated Burst Mode: Output waveform is on or off, based on level of external signal applied
to rear-panel Ext Trig connector. When the gate signal is true, the instrument outputs a continuous
waveform. When the gate signal goes false, the current waveform cycle is completed and the
instrument stops while remaining at the voltage level corresponding to the starting burst phase of the
selected waveform. The noise waveform output stops immediately when the gate signal goes false.

Parameter Burst Mode
(BURS:MOD-

E)

Burst Count
(BURS:NCY-

C)

Burst Period
(BURS:INT:PE-

R)

Burst Phase
(BURS:PHA-

S)

Trigger
Source

(TRIG:SOUR)

Triggered
Burst Mode:

Internal
Trigger

TRIGgered Available Available Available IMMediate

Triggered
Burst Mode:

External
Trigger

TRIGgered Available Not Used Available EXTernal, BUS

Gated Burst
Mode:

External
Trigger

GATed Not Used Not Used Available Not Used

Timer Burst
Mode:

Internal
Trigger

TRIGgered Available Not Used Available TIMer

l In gated mode, burst count, burst period, and trigger source are ignored (used for triggered burst
only). Manual triggers ignored; no error generated.

l In gated mode, you can specify polarity of signal on the rear-panel Ext Trig connector ([SOURce[1|2]:]
BURSt:GATE:POLarity {NORMal|INVerted}). Default is NORMal (true-high).
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l Front Panel:

l SCPI: [SOURce[1|2]:]BURSt:MODE {TRIGgered|GATed}

Waveform Frequency

You can specify the signal frequency during the burst in triggered and external gated modes. In the
triggered mode, the number of cycles specified by the burst count is output at the waveform frequency. In
the external gated mode, the waveform frequency is output when the external gate signal is true.

This differs from the "burst period," which specifies interval between bursts (triggered mode only).

l Waveform frequency: 1 µHz to maximum frequency of the waveform. The default value is 1 kHz. (For
an internally triggered burst waveform, the minimum frequency is 126 µHz in the 33500 Series or 251
µHz in the 33600 Series.)

l Front Panel:

l SCPI: [SOURce[1|2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.
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Burst Count

Number of cycles (1 to 100,000,000 or infinite) to be output per burst. Used in the triggered burst mode
only (internal or external source).

l With the Immediate trigger source, the specified number of cycles are output continuously at a rate
determined by the burst period. The burst period is the time between the starts of consecutive bursts.
Also, the burst count must be less than the product of burst period and waveform frequency:

Burst Period > (Burst Count)/(Waveform Frequency) + 1µsec (33500 Series)

Burst Period > (Burst Count)/(Waveform Frequency) + 500 ns (33600 Series)

l The instrument will increase burst period to its maximum value to accommodate specified burst count
(but waveform frequency will not be changed).

l In gated burst mode, burst count is ignored. However, if you change the burst count from the remote
interface while in the gated mode, the instrument remembers the new count and will use it when the
triggered mode is selected.

l Front Panel:

or

l SCPI: [SOURce[1|2]:]BURSt:NCYCles {<num_cycles>|INFinity|MINimum|MAXimum}
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Burst Period

Burst period, which is used in internal triggered burst mode only, is the time from the start of one burst to
the start of next burst (1 µs to 8000 s, default 10 ms for the 33500 Series). On the 33600 Series, the range
is from 1 µs to 4000 s, and the default is also 10 ms. Burst period differs from "waveform frequency,"
which specifies the frequency of the bursted signal.

l Burst period is used only when Immediate triggering is enabled. The burst period is ignored when
manual or external triggering is enabled (or when the gated burst mode is selected).

l You cannot specify a burst period that is too short for the instrument to output with the specified burst
count and frequency. If the burst period is too short, the instrument will increase it as needed to
continuously re-trigger the burst.

l Front Panel:

l SCPI: [SOURce[1|2]:]BURSt:INTernal:PERiod {<seconds>|MINimum|MAXimum}

Start Phase

Start phase of the burst, from -360 to +360 degrees (default 0).

l Specify the start phase units with UNIT:ANGLe.

l Always displayed in degrees on front panel (never radians). If set in radians from remote interface,
instrument converts value to degrees on the front panel.

l For sine, square, and ramp, 0 degrees is the point at which the waveform crosses 0 V (or DC offset) in a
positive-going direction. For arbitrary waveforms, 0 degrees is the first waveform point. Start phase
has no effect on noise.

l Start phase also used in gated burst mode. When the gate signal goes false, the current waveform
cycle finishes, and output remains at the voltage level of the starting burst phase.

l Front Panel:

l SCPI: [SOURce[1|2]:]BURSt:PHASe {<angle>|MINimum|MAXimum}
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Burst Trigger Source

In triggered burst mode:

l The instrument outputs a waveform of the specified number of cycles (burst count) when a trigger is
received. After the specified number of cycles have been output, the instrument stops and waits for
next trigger.

l IMMediate (internal): the instrument outputs continuously when burst mode is enabled. The rate at
which the burst is generated is determined by BURSt:INTernal:PERiod.

l EXTernal: the instrument accepts a hardware trigger at the rear-panel Ext Trig connector. The
instrument outputs one burst of the specified number of cycles each time Ext Trig receives a level
transition with the proper polarity (TRIGger[1|2]:SLOPe). External trigger signals during a burst are
ignored.

l BUS (software): the instrument initiates one burst each time a bus trigger (*TRG) is received. The
front panel [Trigger] key is illuminated when the instrument is waiting for a bus trigger.

l EXTernal or BUS: burst count and burst phase remain in effect, but burst period is ignored.

l TIMer: trigger events are spaced by a timer, with the first trigger as soon as INIT occurs.

l Front Panel:

l To specify whether the instrument triggers on a rising or falling edge of the signal at the Ext Trig
connector, select the external trigger source before choosing Trigger Setup.

l SCPI:
TRIGger[1|2]:SOURce {IMMediate|EXTernal|TIMer|BUS}

TRIGger[1|2]:SLOPe {POSitive|NEGative}

See Triggering for more information.

If the duty cycle is changed on a triggered bursted square wave with the trigger mode set to
Timer, the current burst will finish and one more burst will be executed before the duty cycle
of the burst changes.
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Trigger Out Signal

A "trigger out" signal is provided on the rear-panel Ext Trig connector (used with burst and sweep only).
When enabled, a pulse with either a rising edge (default) or falling edge is output from this connector at
the beginning of the sweep or burst.

l When the Immediate (internal) trigger source is selected, the instrument outputs a square waveform
with a 50% duty cycle from the Ext Trig connector at the beginning of the sweep or burst. The
frequency of the waveform corresponds to the specified burst period or total sweep time.

l When the External trigger source is selected, the instrument disables the "trigger out" signal. The Ext
Trig connector cannot be used for sweep or burst and trigger out at the same time (an externally-
triggered waveform uses the same connector to trigger the sweep or burst).

l When Manual or bus (software) trigger source is selected, the instrument outputs a pulse (>1 μs pulse
width on the 33500 Series and 100 ns on the 33600 Series) from the Ext Trig connector at the
beginning of each sweep or burst.

l Front Panel

alt="Burst Off softkey"

Then use this softkey to choose the desired edge direction:

l SCPI:
OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF|0}

Triggering

This section describes the instrument's triggering system.
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Trigger Overview

This triggering information applies to sweep and burst only. You can issue triggers for sweeps or bursts
using internal triggering, external triggering, timer triggering, or manual triggering.

l Internal or "automatic" (default): instrument outputs continuously when sweep or burst mode is
selected.

l External: uses rear-panel Ext Trig connector to control sweep or burst. The instrument initiates one
sweep or outputs one burst each time Ext Trig receives a pulse. You can select whether instrument
triggers on rising or falling edge.

l Manual: triggering initiates one sweep or outputs one burst each time you press [Trigger] on the front
panel.

l When you sweep a list, trigger moves the waveform to the next frequency in the list.

l The [Trigger] key is disabled when in remote and when a function other than burst or sweep is
currently selected.

Trigger Sources

This triggering information applies to sweep and burst only. You must specify the source from which the
instrument accepts a trigger.

l Sweep and Burst trigger source: Immediate (default), External, Manual or Timer.

l The instrument will accept a manual trigger, a hardware trigger from the rear-panel Ext Trig
connector, or continuously output sweeps or bursts using an internal trigger. You can also trigger
bursts based on a timer. At power-on, immediate trigger is selected.

l Trigger source setting is volatile; set to internal trigger (front panel) or immediate (remote interface) by
power cycle or *RST.

l Front Panel:
Enable sweep or burst. Then:

l SCPI:TRIGger[1|2]:SOURce {IMMediate|EXTernal|TIMer|BUS}

l The APPLy command automatically sets the source to Immediate.
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Immediate Triggering

Internal trigger mode (default): instrument continuously outputs sweep or burst (as specified by sweep
time or burst period).

Front Panel:

SCPI:TRIGger:SOURce IMMediate

Manual Triggering

Manual trigger mode (front panel only): you manually trigger the instrument by pressing [Trigger]. The
instrument initiates one sweep or burst for each time you press [Trigger]. The button is lit when you are in
the trigger menu and the instrument is waiting for a manual trigger. The button blinks when the
instrument is waiting for a manual trigger, but you are not in the trigger menu. The key is disabled when
the instrument is in remote.

External Triggering

In external trigger mode, the instrument accepts a hardware trigger at the rear-panel Ext Trig connector.
The instrument initiates one sweep or burst each time Ext Trig receives a TTL pulse with the specified edge.
The external trigger mode is like the manual trigger mode except that you apply the trigger to the Ext Trig
connector.

See Trigger Input Signal, below.

Front Panel:

To specify whether the instrument triggers on a rising or falling edge, press Trigger Setup and select the
edge direction by pressing Slope.

SCPI:
TRIGger:SOURce EXTernal

TRIGger[1|2]:SLOPe {POSitive|NEGative}
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Software (Bus) Triggering

Available only from remote interface, this is similar to manual trigger mode from the front panel, but you
trigger the instrument with a bus trigger command. The instrument initiates one sweep or outputs one
burst each time a bus trigger command is received. The key blinks when a bus trigger command is
received.

To select the bus trigger source, send TRIGger:SOURce BUS.

To trigger instrument from remote interface (GPIB, USB, or LAN) when Bus source is selected, send TRIG
or *TRG (trigger). The front panel [Trigger] key is illuminated when the instrument is waiting for a bus
trigger.

Timer Triggering

The timer trigger mode issues triggers a fixed period apart. To select the bus trigger source, send
TRIGger:SOURce TIMer.

Trigger Input Signal

This rear-panel connector is used in the following modes:

l Triggered Sweep Mode: Press Trigger Setup > Source Ext, or execute TRIG:SOUR EXT (sweep must
be enabled). When a level transition of the correct polarity is received on the Ext Trig connector,
instrument outputs a single sweep.

l Externally-Modulated FSK Mode: Press Source or execute FSK:SOUR EXT (FSK must be enabled).
When a low level is present, carrier frequency is output. When a high level is present, hop frequency is
output. Maximum external FSK rate is 100 kHz.

l Triggered Burst Mode: Press Trigger Setup > Source Ext, or execute TRIG:SOUR EXT (burst must be
enabled). The instrument outputs a waveform with specified number of cycles (burst count) each time
a trigger is received from the specified trigger source.

l External Gated Burst Mode: Press Gated softkey or execute BURS:MODE GAT with burst enabled.
When external gate signal is true, instrument outputs a continuous waveform. When external gate
signal goes false, the current waveform cycle completes and then instrument stops while remaining at
voltage level corresponding to starting burst phase. For noise, output stops as soon as the gate signal
goes false.
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Trigger Output Signal

The trigger output signal is chassis referenced, and it is physically next to the external modulation input,
which is floating. Use appropriate care not to touch the two signals simultaneously as you are connecting
or disconnecting these cables. De-energize connections to the instrument output before connecting or
disconnecting these cables.

l A "trigger out" signal is provided on the rear-panel Ext Trig connector (used with burst and sweep
only). When enabled, a pulse with either a rising edge (default) or falling edge is output from this
connector at the beginning of the sweep or burst.

The diagram above shows the triggering on the 33500 Series. On the 33600 Series, the
pulse width is 100 ns, and the voltage level is programmable (not necessarily the +3.3 V
shown). See TRIGger:LEVel for details on how to set this value.

l Internal (immediate) or Timer trigger source: instrument outputs a square wave with a 50% duty
cycle from the Ext Trig connector at the beginning of the sweep or burst. Waveform period equals
specified sweep time or burst period.

l External trigger source: instrument disables "trigger out" signal. The rear-panel Ext Trig connector
cannot be used for both operations simultaneously (an externally-triggered waveform uses the same
connector to trigger sweep or burst).

l Bus (software) or manual trigger source: instrument outputs a pulse (>1 μs pulse width) from Ext
Trig connector at beginning of each sweep or burst.

l Front Panel: Enable sweep or burst. Then:

Then use this softkey to choose the desired edge direction:
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l SCPI:
OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF|0}

Dual Channel Operations

This section covers most topics related to dual channel operation. It does not cover the optional IQ Player.

Entering Dual Channel Operation

You enter dual channel configuration by pressing a channel output button, then More, then Dual
Channel.

Frequency Coupling

Frequency coupling allows you to couple frequencies or sample rates between channels, either by a
constant ratio or offset between them. Press Freq Cpl to turn frequency coupling on or off, and press Freq
Cpl Settings to configure frequency coupling.

The Freq Cpl Settings softkey opens the menu shown below. The first softkey allows you to specify
whether you want to couple the frequencies with a ratio or an offset, and the second softkey allows you to
specify the ratio or offset.
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Amplitude Coupling

Amplitude coupling, enabled by the Ampl Cpl softkey, couples the amplitude and offset voltage between
the channels so that changing the amplitude or offset on one channel affects both channels.

Tracking

Tracking, configured by the Tracking softkey, has three modes: Off, On and Invert. When tracking is off,
the two channels operate independently. When tracking is on, they behave as one channel. The third
mode, Invert, makes the channels’ outputs inverses of each other, resulting in a differential channel using
both outputs.

Combine

The Combine feature combines two outputs into one connector. If you choose CH2 from the Channel 1
menu, they are combined on channel 1; choosing CH1 from the Channel 2 menu combines them on
channel 2.

In the image below, the top waveform is a 100 mVpp, 1 kHz sine wave on channel 1, and the bottom
waveform is a 100 mVpp, 5 kHz sine wave on channel 2.

The image below shows the two outputs combined on channel 1. Note that the X-axis has been
compressed (zoomed out) to show more cycles.
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The signals being combined do not have to be of the same type; for example, this image shows the same 5
kHz channel on channel 2 combined with a 100 mVpp square wave on channel 1.

When signals are combined, the DC Offset values are not added together. Only the DC Offset from the
receiving channel is used in the combined output. The figure below shows 50 a mV DC Offset added to
Channel 1. The 50 mV offset added to Channel 2 is ignored.

You may also use Combine with bursts. For example, consider the image below, which includes a 1 kHz
sine wave on channel 1 and three-cycle bursts of a 5 kHz sine wave on channel 2.
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When these signals are combined on channel 1, the result is a simple amplitude addition of the two
signals, as shown below.

You also can combine the signals on channel 2, as shown below.

IQ Player (Optional)

The optional IQ Player is used to play dual arbitrary waveforms, such as IQ baseband signals.

A dual arbitrary waveform is analogous to a stereo music file. It has two channels of information that
contain the same number of samples, always start and end together, and always play at the same sample
rate.

File Formats

The instrument's native .ARB and .BARB files can contain either one or two channels of data. These files
are typically created in Keysight BenchLink Waveform Builder software, and you can directly play them on
the instrument.

You can also directly play files ending in .DAT, .ASC, .I, and .Q. These file formats contain one or two
columns of ASCII numbers ranging between -1.0 and 1.0, in either scientific or decimal notation. The data
represents the relative "shape" of the waveform at the current amplitude range.

Operating Information

145 Keysight Trueform Series Operating and Service Guide

http://www.keysight.com/find/33503


Finally, you can import one- or two-column data files in .CSV or .TXT format. To import a file, press 
[Waveforms] > Arb > Arbs > Import Data. This opens a menu interface that quickly guides you through
the process of importing a file.

Front Panel

Once you have a dual arbitrary waveform as the active waveform, the tab changes to a purple color, as
shown below.

The waveform image is a constellation diagram, but you can change it to a time domain diagram. To do
this, press [System] > System Setup > Screen Layout. This takes you to the following menu:

Pressing the Time softkey changes the graphic to a time domain image:
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Balance Adjust

If you press More from the [Parameters] menu, you will go to page 2 of the [Parameters] menu:

From this menu, you can press Balance Adjust to open a menu that will allow you specify the balance
amplitude gain and channel offsets:

IQ Arb Skew

To compensate for minor channel-channel time skew, begin by pressing either of the channel output
buttons and then pressing More to go to page 2 of the menu:

On this menu, press IQ Arb Skew to open the following menu, which allows you to compensate for up to
4 ns of skew on the 33500 Series or 1 ns of skew on the 33600 Series:
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SCPI Commands

There are eight SCPI commands associated with the IQ Player:

Loading Dual Arbitrary Waveforms

[SOURce[1|2]:]DATA:ARBitrary[1|2] <arb_name>, {<binary_block>|<value>, <value>, . . .}

[SOURce[1|2]:]DATA:ARBitrary[1|2]:DAC <arb_name>, {<binary_block>|<value>, <value>, . . .}

[SOURce[1|2]:]DATA:ARBitrary2:FORMat {AABB|ABAB}

Adjusting Playback of Dual Arbitrary Waveforms

FUNCtion:ARBitrary:BALance:GAIN {<percent>|MINimum|MAXimum|DEFine}

FUNCtion:ARBitrary:BALance:OFFSet{1|2} {<volts>|MINimum|MAXimum|DEFault}

FUNCtion:ARBitrary:BALance[:STATe] {ON|1|OFF|0}

FUNCtion:ARBitrary:SKEW[:STATe] {ON|1|OFF|0}

FUNCtion:ARBitrary:SKEW:TIME [{<time>|MINimum|MAXimum|DEFault}]

System-Related Operations

This section covers instrument state storage, power-down recall, error conditions, self test, and display
control. Though unrelated to waveform generation, these operations are important for instrument
operation.

Instrument State Storage

l There are two ways to store and retrieve instrument states:

l Named state files, using front panel or MMEMory:STORe:STATe and MMEMory:LOAD:STATe

l Memory locations 1 through 4, using *SAV and *RCL

For 33600 Series instruments, the state files associated with *SAV and *RCL are saved in files
called STATE_0.STA through STATE_4.STA. These files are located in the Settings directory of
internal memory. You can manage these files usingMMEMory commands.

l You can also use special storage location 0 with *SAV and *RCL, but location 0 is overwritten by the
current instrument state on power down.

l Both state storage methods remember the selected function (including arbitrary waveforms),
frequency, amplitude, DC offset, duty cycle, symmetry, and modulation parameters.

l If you delete an arbitrary waveform from non-volatile memory after storing the instrument state, the
waveform data is lost and the instrument uses "exponential rise" in its place.

l Stored states are not affected by *RST; a stored state remains until overwritten or specifically deleted.
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l Front Panel:

To save a state:

The state file will be created with .sta extension, using the name you specified with the knob and
arrows.

To recall a state:

Use the right arrow to expand a folder. To select a file, press Select.

To delete a state:

Use the knob and arrows to select .sta file, and then press Select.

l You can configure instrument to power-down state from location 0 on power up. The factory default is
to recall factory default state at power-on.

l Front Panel:

l SCPI: MEMory:STATe:RECall:AUTO {ON|1|OFF|0}
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Error Conditions

Up to 20 command syntax or hardware errors can be stored in each interface-specific error queue (one
each for GPIB, USB, VXI-11, and Telnet/Sockets.) See SCPI Error Messages for more information.

l Front Panel:

l SCPI: SYSTem:ERRor?

Beeper Control

The instrument normally beeps when an error is generated from the front panel or remote interface.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

l SCPI:
SYSTem:BEEPer:STATe {ON|1|OFF|0}

SYSTem:BEEPer

On the 33600 Series, you can also enable and disable the click heard when a key is pressed.
See SYSTem:CLICk:STATe for details.

Display Screen Saver

The display's backlight normally turns off and reduces the screen brightness after eight hours of inactivity.
You may disable this screen saver from the front panel only.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:
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Display Brightness

You can adjust display brightness (10% to 100%) from the front panel only.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

Date and Time

You can set the instrument's date and time clock.

l Front Panel:

l SCPI:
SYSTem:DATE <yyyy>, <mm>, <dd>

SYSTem:TIME <hh>, <mm>, <ss>
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Manage Files

You can perform file management tasks, including copying, renaming, deleting, and creating new folders.

l Front Panel:

l You can copy, rename, or delete files or folders. Deleting a folder removes all of the files within the
folder, so be sure that you want to delete all of the files within the folder.

l The most important softkey is Action, which allows you to specify the operation to perform. Once you
have chosen the action to perform, press Browse to select the file to manage. Once you are
completely prepared to execute the task, press Perform.

l SCPI: (see MEMory and MMEMory subsystems).

Self-Test

l A limited power-on self-test occurs when you turn on the instrument to assure you that the
instrument is operational. You can also run a more complete self-test. For details, see Self-Test
Procedures.
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Display Control

For security reasons, or to speed up the rate at which the instrument executes remote interface
commands, you may want to turn off the display. You can also remotely display a message or clear a
message on the display.

l The display is enabled when power is cycled, after an instrument reset (*RST), or when you return to
local (front panel) operation. Press the [Local] key or execute the IEEE-488 GTL (Go To Local)
command from the remote interface to return to the local state.

l The display state is saved when you store the instrument state with *SAV recalled by *RCL.

l Front Panel:

l SCPI:
DISPlay {ON|1|OFF|0}

DISPlay:TEXT "<string>"

DISPlay:TEXT:CLEar

Number Format

The instrument can display numbers on the front panel with periods or commas for the decimal point and
digits separator. The default is a period decimal point with commas for digit separation (1.000,000,00
kHz).

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

l SCPI: (No equivalent command)

Operating Information

153 Keysight Trueform Series Operating and Service Guide



Firmware Revision Query

Send *IDN? to determine which revision of firmware is currently installed. The query returns a string of the
form:

Keysight Technologies,[Model Number],[10-char Serial Number],A.aa-B.bb-C.cc-DD-EE

l Front Panel:

l SCPI: *IDN?

SCPI Language Version Query

The instrument complies with the rules and conventions of the present version of SCPI (Standard
Commands for Programmable Instruments). Use SYSTem:VERSion? to determine the SCPI version with
which the instrument complies. The query returns a string in the form "YYYY.V", representing the year and
version number for that year (for example, 1999.0).

License Installation

The Trueform Series has several optional features that require licenses for installation. To install a license:

1. Install the license file onto a USB drive and insert the USB drive into the instrument’s front panel.

2. Press [System] > System Setup > Install License.

3. Use the knob and arrows to select the file under External, then press Enter.

There are also several SCPI commands associated with license installation.

Remote Interface Configuration

The instrument supports remote interface communication over three interfaces: GPIB (optional), USB, and
LAN. All three are "live" at power up.

l GPIB Interface: Set the instrument's GPIB address connect to your PC using a GPIB cable.

l USB Interface: No configuration; simply connect instrument to PC with a USB cable.

l LAN Interface: By default, DHCP is on, which may enable communication over LAN. The acronym
DHCP stands for Dynamic Host Configuration Protocol, a protocol for assigning dynamic IP addresses
to networked devices. With dynamic addressing, a device can have a different IP address every time it
connects to the network.
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Connectivity Software and Product CDs

The instrument ships with two CDs:

l Keysight IO Libraries Suite CD: Contains Keysight IO Libraries Suite software, which must be
installed to enable remote-interface operations. The CD auto-starts and provides information on
installing the software. Also includesKeysight Technologies USB/LAN/GPIB Connectivity Guide,
which contains additional information.

l Keysight Trueform Series Product Reference CD: Contains instrument drivers, product
documentation, and programming examples. Auto-starts and provides instructions.

GPIB Configuration

Each device on the GPIB (IEEE-488) interface must have a unique whole number address between 0 and
30. The instrument ships with a default address of 10, and the GPIB address is displayed at power-on.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Your computer’s GPIB interface card address must not conflict with any instrument on the interface
bus.

l Front Panel:
Press [System] > I/O Config > GPIB Settings to set the GPIB address and turn GPIB on or off.

l SCPI:
SYSTem:COMMunicate:GPIB:ADDRess <address>

SYSTem:COMMunicate:ENABle <state>,GPIB

SYSTem:COMMunicate:ENABle? GPIB

LAN Configuration

The following sections describe the primary front panel LAN configuration functions, including SCPI
commands where applicable. Some LAN configuration functions that can be performed only via SCPI. See
LAN Configuration Introduction for all LAN configuration commands, and see LAN Configuration
Procedure for a procedure to configure the LAN via the front panel.

Some LAN settings require you to cycle power on the instrument in order for them to
be activated. The instrument briefly displays a message when this is the case, so be sure
to watch the screen closely as you change LAN settings.
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Resetting the LAN

You can clear the Web Interface password, turn DHCP on, and restart the LAN at any time:

l Front panel:

The message "Performing LAN Reset" is displayed while the LAN is reset.

l SCPI: (No equivalent command)

DHCP On/Off

DHCP (Dynamic Host Configuration Protocol) can automatically assign a dynamic IP address to a LAN
device. Typically easiest way to configure instrument for LAN.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

Finally, toggle the first softkey to DHCP to use DHCP to automatically assign an IP address.

l SCPI: SYSTem:COMMunicate:LAN:DHCP {ON|1|OFF|0}

To manually set an IP address, Subnet Mask, or Default Gateway, turn DHCP off, then change IP setup as
described below.
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IP Address

You can enter a static IP address for the instrument as a four-byte integer expressed in dot notation. Each
byte is a decimal value, with no leading zeros (for example, 169.254.2.20).

l If DHCP is on, it attempts to assign an IP address to the instrument. If it fails, AutoIP attempts to assign
an IP address to the instrument.

l Contact your LAN administrator to obtain an IP address.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

l Finally, toggle the first softkey to Manual and press IP Address to enter a new IP address. Enter the
desired address.

l SCPI: SYSTem:COMMunicate:LAN:IPADdress "<address>"

Subnet Mask

Subnetting allows the LAN administrator to subdivide a network to simplify administration and minimize
network traffic. The subnet mask indicates the portion of the host address used to indicate the subnet.

l Contact your LAN administrator for details.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

l Finally, toggle the first softkey to Manual and press Subnet Mask to enter a new subnet mask with
the numeric keypad or knob (for example: 255.255.0.0).

l SCPI: SYSTem:COMMunicate:LAN:SMASk "<mask>"
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Default Gateway

A gateway is a network device that connects networks. The default gateway setting is the IP address of
such a device.

l You need not set a gateway address if using DHCP or AutoIP.

l Contact your LAN administrator for gateway details.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

Finally, toggle the first softkey to Manual and press More and Gateway. Then set the appropriate
gateway address using the numeric keypad or knob.

l SCPI: SYSTem:COMMunicate:LAN:GATeway "<address>"

Hostname

A hostname is the host portion of the domain name, which is translated into an IP address.

l The instrument receives a unique hostname at the factory, but you may change it. The hostname must
be unique on the LAN.

l The name must start with letter; other characters can be upper or lower case letters, numeric digits, or
dashes ("-").

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

Finally, press Host Name and enter the hostname with the knob and arrows. The knob changes the
character; cursor arrows move between characters.

l SCPI: SYSTem:COMMunicate:LAN:HOSTname "<name>"

Domain Name

A domain name is a registered Internet name that gets translated into an IP address. You cannot set it from
the front panel or SCPI.
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DNS Server

DNS (Domain Name Service) is an Internet service that translates domain names into IP addresses. The
DNS server address is the IP address of a server that performs this service.

l Normally, DHCP discovers DNS address information; you only need to change this if DHCP is unused
or not functional. Contact your LAN administrator for DNS server details.

l This setting is non-volatile; it will not be changed by power cycling or *RST.

l Front Panel:

Finally, toggle the first softkey to Manual and press More and Primary DNS or Second DNS to enter
a DNS address using the numeric keypad or knob.

l SCPI: SYSTem:COMMunicate:LAN:DNS[1|2] "<address>"

Current Configuration (LAN)

l Select the Currently Active Settings display to view the MAC address and current LAN configuration.

l Front Panel:

l SCPI: (No equivalent command)

The display reflects only currently active settings when first displayed; it does not update with changes
occurring after the information is displayed. For example, if DHCP assigns an IP address with display open,
a new IP address will not appear.

If the instrument goes into remote, all LAN changes will be canceled, and the display will go to a different
screen. Re-selecting the LAN Settings page will display the new settings if a LAN restart took place.

See SYSTem Subsystem Introduction for additional LAN configuration commands.
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Web Interface

The instrument includes a built-in Web Interface. You can use this interface over LAN for remote
instrument access and control via a Java™-enabled Web browser, such as Microsoft Internet Explorer.

To use the Web Interface:

1. Establish a LAN connection from your PC to the instrument.

2. Open your PC's Web browser.

3. Launch the instrument's Web Interface by entering the instrument's IP address or fully-qualified
hostname in the browser address field.

4. Follow the instructions in the Web Interface's on-line help.
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USB Configuration

Front Panel:

On the 33500 Series, there are no user-configurable USB parameters. You can only retrieve the USB ID
string (set by the manufacturer) by using the Show USB Id softkey.

Easy File Access (33600 Series only)

Easy File Access uses media transfer protocol (MTP) to easily download instrument files to your PC.
Simply connect the rear-panel USB port on the instrument to a USB port on your PC. The DMM will
appear as a read-only drive on your PC's file system. Note that the instrument's internal storage includes a
pre-defined directory structure, as shown below.

You can use your PC's standard file management features to copy files from the DMM to your PC.

To use Easy File Access at the same time that you are remotely programming the
instrument with SCPI over the USB interface (USB SCPI), you must have Keysight IO
Libraries Suite 16.3 or later installed on your PC. You may download the latest version at
www.keysight.com/find/iosuite.

To use Easy File Access on a PC running the Windows XP operating system, make sure you have Microsoft
Windows Media Player 11 for Windows XP or later installed before you hook up the USB cable. You may
download this software at www.microsoft.com/en-us/download/details.aspx?id=8163.

External Timebase Reference

The external 10 MHz reference input BNC connector, both the shell and center pin, on the
rear panel of the instrument is isolated up to ±42 Vpk from chassis. The shell of this BNC
connector is isolated from the rest of the instrument. Internal circuitry will attempt to keep
the isolated voltage to within ±42 Vpk to chassis. Attempts to float this input beyond±42 Vpk
from chassis may destroy the instrument and cause a hazard that could result in personal
injury or death.
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The external timebase reference provides rear panel connectors (10 MHz In and 10 MHz Out) and
circuitry to allow synchronization between multiple instruments or to an external 10 MHz clock signal.
You can also set the phase offset of the output waveform from the front panel or over the remote
interface.

To align the phase of two instruments, use a dual-channel oscilloscope to compare the output signals:

1. Connect the two instruments, with 10 MHz Out connected to 10 MHz In. Use the instrument with the
more precise timebase as the 10 MHz reference output source.

2. Connect instrument outputs to scope channel inputs:

3. Set the same frequency on both instruments. The scope should show the signals to be in sync with
regard frequency, but not phase. (A square wave works well to show the phase difference.)

4. For two-channel instruments, phase sync the two channels to each other. This also synchronizes each
channel’s modulating waveforms to the carrier.

Front panel:

SCPI: [SOURce[1|2]:]PHASe:SYNChronize

5. Leaving the phase setting at its default (zero) on the first instrument, use Adjust Phase to adjust the
phase of the second instrument to align the output signals:
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Out of Phase Aligned

You can use Set 0 Phase to set a new zero-phase reference point with the two instruments now aligned.

l Front Panel:

Then set the phase angle using the keypad or knob. Once they are aligned, press Set 0 Phase.

l SCPI:
[SOURce[1|2]:]PHASe {<angle>|MINimum|MAXimum|DEFault}

[SOURce[1|2]:]PHASe:REFerence

Embedded Waveform Editor

The instrument includes an embedded waveform editor for creating and editing single-channel arbitrary
waveforms in ASCII arbitrary waveforms (.ARB suffix). You can enter and edit voltage values directly or by
combining up to 12 different kinds of standard waveforms, as described in the following sections:

Standard Waveforms

Basic Waveform Editing

Advanced Edit

Advanced Math

Utility Menu

Regardless of what options may be installed, the maximum waveform size for the embedded
waveform editor is 1 MSa.

Standard Waveforms

The embedded waveform editor includes the following 12 waveforms:

Sine y = sin(x)
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Square A square wave that switches between two voltage levels

Ramp A waveform with linearly rising or falling voltage

Line Line segment

DC A DC voltage

Noise Random noise

Gaussian A gaussian bell curve (normal distribution)

Sinc y = sin(x)/x

D-Lorentz The derivative of the Lorentz function. The Lorentz function is y = 1/
(x²+1), so the D-Lorentz function is y = -2x/(x²+1)².

Expo Fall Exponential decay: y = e-kx

Expo Rise Exponential rise: y = 1 – e-kx

Haversine y = [1 – cos(x)]/2
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When you select a waveform, the instrument displays a screen for specifying the waveform’s parameters,
listed below.

Amplitude The peak height above 0 V when the waveform has 0 offset, from 10 μV to 10 V (default 1).

Offset The distance the waveform is shifted up or down relative to 0 V, from -10 to 10 V (default
0).

The Amplitude plus the Offset must be between -10 V and 10 V.

Phase The number of degrees that the waveform is advanced (positive value) or retarded
(negative value) from 0 degrees, from -360 to 360 (default 0).

Cycles The number of complete output cycles (a positive integer) that the waveform includes.

Points The number of points the waveform includes up to 1,000,000 (default 100). The minimum
number of points on the 33500 Series is 8, and the minimum number of points on the
33600 Series is 32.

Half Width
(D-Lorentz
only)

A value that controls the waveform width; larger values make wider curves. An integer
from 1 to the total number of points in one cycle (default 10).

Fall Factor
(Expo Fall
only)

A decimal number from -99 to 99 that controls how fast the waveform falls or rises (default
-5).

Rise Factor
(Expo Rise
only)

Full Width
(Gaussian
only)

The width of the bell curve between the points on the curve that are one-half the curve's
height, from 1 to the number of points in one cycle (default 10).

Symmetry
(Ramp only)

The percentage of time (per cycle period) that the ramp rises, a decimal from 0 to 100
(default 100).

Zero
Crossing

(Sinc only)

The number of times the waveform crosses the horizontal axis on one side of the waveform,
from 0 to 100 (default 10).

Duty Cycle

(Square
only)

The percentage of the time (per cycle period) that the waveform voltage is high, from 0 to
100 (default 50).

Start Level

(Line only)

The voltage at the beginning or end of the line segment.

End Level

(Line only)
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Basic Waveform Editing

When you start the embedded waveform editor ([Waveforms] > Arb > Arbs > Edit Arb File > New Arb
File), the opening screen appears. (Note that the same menu that contains the Edit Arb File softkey also
contains an Import Data softkey. You can use this to import ASCII files from oscilloscopes and other
common instruments.)

Edit Points allows you to edit the voltage values of individual points in the waveform. You can also insert
and remove points in the waveform, and you can access the Advanced Edit features, described below. The
current screen image shows the default new arbitrary waveform of 8 points at 0 VDC.

The default arbitrary waveform size is 8 points the 33500 Series and 32 points on the 33600
Series.
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Edit Params allows you to set the waveform’s sample rate, which is the rate (in points per second) in
which the waveform is played. You can specify this value as a rate or as a period. If you change one, the
other will recalculate based on the number of points in the waveform. This feature also allows you to
specify whether the waveform is labeled with units of time or points along the horizontal axis.

Insert Built-In allows you to insert one of 12 pre-defined waveforms into the current waveform.

Select Point # allows you to specify where the waveform is to be inserted, and the Choose Wave softkey
allows you to specify which one of the 12 waveform types is to be inserted.
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Once you have used the arrow keys to select the waveform to insert and pressed OK, the instrument
displays the parameters for the waveform to be inserted. Note the up and down arrow softkeys, which you
use to select a parameter for editing. Specify the parameters and press OK.

Save allows you to save the current waveform at its current location in the instrument’s internal memory.

Exit Editor closes the waveform editor and resumes normal operation.

If you have unsaved changes, a message gives you the option of staying in the embedded waveform editor.
After you exit the editor, you will have the option to play the waveform on the waveform generator.

Keysight Trueform Series Operating and Service Guide 168

Operating Information



Advanced Edit

As described above, the Edit Points menu includes an Advanced Edit softkey. This softkey allows you to
cut, copy and paste portions of the waveform, edit waveform points in a table, and perform mathematical
operations on the waveform.

Cut/Copy/Paste allows you to define a range of the waveform between two markers and then cut or copy
the waveform points defined by the markers. Once you have cut or copied the range, you can paste it as
many times as desired by using the Paste softkey.

Paste Location allows you to paste a range at the start of the waveform, the end of the waveform, or any
point within the waveform.
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Edit Via Table allows you to edit the voltage values of individual points in a table. You can use the knob to
scroll through the table, or you can use the Point # softkey to directly select any particular point. You can
also insert or remove waveform points.

Perform Math allows you to use markers to specify a range of the waveform. You can then add, subtract,
or multiply the voltage values in that range by the voltage values in another waveform.

Once you have pressed Add, Subtract, or Multiply, the instrument displays a list of waveforms. Pick the
waveform and press OK.
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When you press OK, the instrument displays a list of parameters that you can use to specify the waveform.
In this case, the screen below shows that you picked D-Lorentz. You can also use the From Point and To
Point parameters to specify the range of points on which to perform the mathematical operation.

Advanced Math

Advanced Math allows you to perform several mathematical operations on the waveform. To begin, press
Edit Points > Advanced Edit > Perform Math > Advanced Math.

The Advanced Math menu opens with the following screen. Each of the operations shown below will be
described below, using images taken before and after each operation to demonstrate the operations’
effects.
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Invert reflects the waveform across the horizontal axis.

Image Before Invert

Image After Invert
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Absolute multiplies all negative waveform values by -1.

Image Before Absolute

Image After Absolute

Mirror reverses order of the points in the range.

Image Before Mirror

Image After Mirror
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Scale allows you to scale the waveform’s amplitude and offset. Here, the amplitude scale was set to 180%
and the offset scale was set to 1 V.

Image Before Scale

Image After Scale
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Clip allows you to change voltage values outside upper and lower limits to be equal to the limits. In this
example, the waveform was clipped to stay within the -400 mV lower limit and the 700 mV upper limit.

Image Before Clip

Image After Clip
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Trim allows you to use markers to "crop" the waveform so that only the points defined by the marker
range remain in the waveform.

Image Before Trim

Image After Trim
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Utility Menu

You can access several utility features by pressing the [System] key from within the embedded waveform
editor.

Undo allows you to undo recent operations, subject to the amount of available memory and the size of the
undo operation. Redo allows you to redo "undone" tasks, subject to the same limitations.

Pan/Zoom Control allows you to pan or zoom horizontally or vertically. You zoom using a percentage
zoom factor, and you pan by specifying a point, and or voltage.

Show All resets the scaling to display the entire waveform.

Waveform Generation Tutorial

This section describes theory of operation information for several waveform types and instrument
operating modes. The last two topics include information that may help you improve signal quality.

l Arbitrary Waveforms

l Quasi-Gaussian Noise

l PRBS

l Modulation

l Burst

l Frequency Sweep

l Attributes of AC Signals
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l Signal Imperfections

l Ground Loops

Arbitrary Waveforms

Arbitrary waveforms can meet needs not met by the instrument’s standard waveforms. For example, you
might need a unique stimulus, or you might want to simulate signal imperfections such as overshoot,
ringing, glitching, or noise. Arbitrary waveforms can be very complex, making them suitable for simulating
signals in modern communications systems.

You can create arbitrary waveforms from a minimum of 8 points (33500 Series) or 32 points (33600 Series)
up to 1,000,000 points. The instrument stores these numeric data points, known as "samples," in memory
and then converts them into voltages as the waveform is generated. The frequency at which points are
read is the "sample rate," and the waveform frequency equals the sample rate divided by the number of
points in the waveform. For example, suppose a waveform has 40 points and the sample rate is 10 MHz.
The frequency would be (10 MHz)/40 = 250 kHz and its period would be 4 µs.

Dual Arbitrary Waveforms

Arbitrary waveforms may be single-channel waveforms, or (with option IQP), they may be dual-channel
arbitrary waveforms, such as IQ baseband signals. A dual arbitrary waveform is analogous to a stereo
music file. It has two channels of information that contain the same number of samples, always start and
end together, and always play at the same sample rate.

You can control the skew and balance between channels on dual arbitrary waveforms either via
commands in the SCPI FUNCtion subsystem or via the front panel.

Waveform Filters

The instrument includes two filters to smooth transitions between points as arbitrary waveforms are
generated.

l Normal filter: a wide, flat frequency response, but its step response exhibits overshoot and ringing

l Step filter: a nearly ideal step response, but with more roll-off in its frequency response than the
Normal filter

l Off: output changes abruptly between points, with a transition time of approximately 10 ns.

Each filter’s cutoff frequency is a fixed fraction of the waveform’s sample rate. The Normal filter’s response
is -3 dB at 27% of the sample rate and the Step filter’s response is -3 dB at 13% of the sample rate. For
example, for an arbitrary waveform at 100 MSa/s, the Normal filter’s -3 dB frequency bandwidth is 27
MHz.

Turning the filter off may change the sample rate to a lower rate if the sample rate was greater than 250
MSa/s before the filter was turned off.
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Waveform Sequencing Applications

Arbitrary waveform sequences are useful when the waveform you want to generate in two situations:

l The waveform is very long and contains repetitions of shorter fragments. These fragments can be
repeated any number of times in any order.

l You need real-time control (triggers) to change from one waveform fragment to another.

For an example of the first case, consider a signal that must play the same introductory waveform several
times, then play three other waveforms once each, and then return to play the first waveform
continuously. This might be a simulated modem data packet consisting of an "idle" signal, a header, some
data, a checksum, and a return to the "idle" signal.

This might consist of the following sequence description:

1. Play "idle.arb" 10 times

2. Play "header.arb" once

3. Play "data.arb" once

4. Play "checksum.arb" once

5. Play "idle.arb," repeating indefinitely.

In the second case, you may want to initiate the sending of "header.arb" using an external hardware
trigger. This case might use the following description:

1. Play "idle.arb" repeatedly until a trigger is received

2. Play "header.arb" once

3. Play "data.arb" once

4. Play "checksum.arb" once

5. Play "idle.arb," repeating indefinitely.

A sequence file (*.seq) contains the information in the numbered lists, and the arbitrary waveform files
(*.arb) contain the individual waveforms themselves.
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Waveform Sequencing Implementation

The instrument can assemble long, complex sequences of arbitrary waveforms (segments). Switching
between segments occurs seamlessly in real time. As an analogy, think of segments as songs in a music
player and sequences as play lists.

Each sequence step specifies a segment and how many times it is played. It also specifies whether the
sequence waits for a trigger before the next step and how the Sync signal is generated on a step-by-step
basis.

For each segment, you can either:

l play the segment from 1 to 1,000,000 times and then advance to the next step

l play the segment once and then stop and wait for a trigger before advancing

l repeat the segment until a trigger occurs and then advance

l repeat the segment until explicitly stopped

Options for Sync signal generation include:

l assert Sync at the beginning of the segment

l negate Sync at the beginning of the segment

l maintain the current Sync state throughout the segment

l assert Sync at the beginning of the segment and negate it at a defined point within the segment

To start a sequence on a trigger, place a brief DC waveform of 0 V (or any other desired value) in front of
the other waveforms in the sequence, and set the segment to wait for a trigger before advancing. For
33500 Series instruments, the minimum segment length is 8 Sa, and for 33600 Series instruments, the
minimum segment length is 32 Sa.

If a segment is set up to repeat until a trigger is received, the segment will always finish before
continuing to the next segment. In addition, a short segment may repeat for additional cycles
in order to clear the sequence sample buffer before continuing.

Quasi-Gaussian Noise

The Noise waveform is optimized for both quantitative and qualitative statistical properties. It does not
repeat for more than 50 years of continuous operation. Unlike a true gaussian distribution, there is zero
probability of getting a voltage beyond the instrument’s Vpp setting. The crest factor (peak voltage
divided by RMS voltage) is approximately 4.6.

You can vary the Noise bandwidth from 1 mHz to the instrument's maximum bandwidth. The energy in the
noise signal is concentrated in a band from DC to the selected bandwidth, so the signal has greater
spectral density in the band of interest when the bandwidth setting is lower. In audio work, for example,
you might set the bandwidth to 30 kHz, to make the audio band signal strength 30 dB higher than if the
bandwidth were set to 30 MHz.
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PRBS

A Pseudo-Random Bit Sequence (PRBS) has two levels (high and low), and it switches between them in a
manner that is difficult to predict without knowing the sequence generation algorithm. A PRBS is
generated by a linear-feedback shift register (LFSR), shown below.

An LFSR is specified by the number of stages it contains and which stages ("taps") feed the exclusive-or
(XOR) gates in its feedback network. The PRBS output is taken from the last stage. With properly chosen
taps, an L-stage LFSR produces a repetitive PRBS of length 2L-1. The clocking frequency of the LFSR
determines the "bit rate" of the PRBS.

The 33500 Series models allow you to set L to 7, 9, 11, 15, 20, or 23, resulting in sequences from 127 to
8,388,607 bits in length.

The 33600 Series models allow you to set L to any whole number value from 3 to 32, resulting in
sequences from 7 to 4,294,967,295 bits in length.

The default value for L is 7, resulting in a sequence of 127 bits in length.
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Modulation

Amplitude Modulation (AM)

The instrument implements two forms of AM:

l Double-sideband full-carrier (DSB-FC), which has an ITU designation of A3E and is used in AM
broadcasting.

The equation for DSB-FC is

y(t)= [(½)+(½)•d•m(t)]•A
c
•sin(ω

c
t)

where

m(t) is the modulating signal
A

c
is the carrier amplitude

ω
c

is the carrier frequency of the carrier
  d is the "modulation depth," or fraction of the amplitude range is used by the modulation

For example, a depth setting of 80% varies the amplitude from 10% to 90% of the amplitude setting
(90% - 10% = 80%) with either an internal or a full-scale (±5 V on the 33500 Series, ±5 V or ±1 V on
the 33600 Series) external modulating signal. You may set depth as high as 120%, as long as you do
not exceed the instrument’s maximum output voltage of (±5 V into 50 Ω, ±10 V into high impedance).

The top trace below represents the modulating signal; the bottom trace represents the modulated
carrier.

l Double-sideband suppressed-carrier (DSSC). Many modern communications systems employ DSSC
on each of two carriers that have the same frequency but a 90-degree phase difference. This is called
quadrature amplitude modulation (QAM).

The equation for DSSC is y(t)=d•m(t)•sin(ω
c

t)
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In DSB-SC, the carrier signal is inverted whenever m(t) < 0. For QAM, the second carrier signal would
be cos(ω

c
t), making it 90 degrees out of phase from the first carrier.

Frequency Modulation (FM)

Frequency modulation varies a carrier signal’s frequency according to the modulating signal:

y(t)=A
c
•sin[(ω

c
+d•m(t) )•t]

where m(t) is the modulating signal and d is the frequency deviation. FM is called narrowband if the
deviation is less than 1% of the modulating signal’s bandwidth, and wideband otherwise. You can
approximate the modulated signal’s bandwidth with the following equations.

BW ≈ 2•(Modulating Signal Bandwidth) for narrowband FM

BW ≈ 2•(Deviation+Modulating Signal Bandwidth) for wideband FM

The top trace below represents the modulating signal; the bottom trace represents the modulated carrier.

Phase Modulation (PM)

PM is similar to FM, but the phase of the carrier waveform is varied, rather than the frequency:

y(t)=sin[ω
c

t+d•m(t) ]

where m(t) is the modulating signal and d is the phase deviation.
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Frequency-Shift Keying (FSK) Modulation

FSK is similar to FM, except the carrier frequency alternates between two preset values, the carrier
frequency and the hop frequency. Sometimes the hop and carrier frequencies are called "Mark" and
"Space," respectively. The rate at which the switching between these values occurs is determined by an
internal timer or the signal on the rear-panel Ext Trig connector. Frequency changes are instantaneous
and phase-continuous.

The internal modulating signal is a square wave with 50% duty cycle.

The top trace below represents the modulating signal; the bottom trace represents the modulated carrier.

Binary Phase Shift Keying (BPSK)

BPSK is similar to FSK, except it is the carrier’s phase, rather than its frequency, that switches between two
values. The rate at which the switching between these values occurs is determined by an internal timer or
the signal on the rear-panel Ext Trig connector. Phase changes are instantaneous.

The internal modulating signal is a square wave with 50% duty cycle.

Pulse Width Modulation (PWM)

PWM is only available for the Pulse waveform, and the pulse width varies according to the modulating
signal. The amount by which the pulse width varies is called the width deviation, and it can be specified as
a percentage of the waveform period (that is, duty cycle) or in units of time. For example, if you specify a
pulse with 20% duty cycle and then enable PWM with a 5% deviation, the duty cycle varies from 15% to
25% under control of the modulating signal.
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Additive Modulation (Sum)

The "Sum" feature adds the modulating signal to the carrier. For example, you can add controlled
amounts of variable-bandwidth noise to a signal or create two-tone signals. The instrument's internal
modulation generator can produce the same continuous waveform as the main generator, so the Sum
function lets you to create many signals that would have required two instruments before.

The Sum feature increases the amplitude of the output signal by the amplitude of the modulating signal.
This might cause the instrument to switch to a higher output-voltage range, resulting in a momentary
signal loss. If this is a problem in your application, turn on the Range Hold function. If the voltage increase
could damage your device under test, apply Voltage Limits.
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Burst

You can configure the instrument to output a waveform with for a specified number of cycles, called a
burst. You can use burst in one of two modes: N-Cycle Burst (also called "triggered burst") or Gated Burst.

An N-Cycle burst consists of a specific number of waveform cycles (1 to 1,000,000) and is always initiated
by a trigger event. You can also set the burst count to "Infinite," which results in a continuous waveform
once the instrument is triggered.

In the image below, the top trace is the sync output, and the bottom one is the main output.

Three-Cycle Burst Waveform

For bursts, the trigger source can be an external signal, an internal timer, the key, or a command from the
remote interface. The input for external trigger signals is the rear-panel Ext Trig connector. This connector
is referenced to chassis ground (not floating ground). When not used as an input, the Ext Trig connector
can be configured as an output to enable the instrument to trigger other instruments at the same time
that its internal trigger occurs.

An N-Cycle burst always begins and ends at the same point in the waveform, called the start phase.

In GATed burst mode, the output waveform is on or off, based on the signal at the rear-panel Ext Trig
connector. Select this signal's polarity using BURSt:GATE:POLarity. When the gate signal is true, the
instrument outputs a continuous waveform. When the gate signal goes false, the current waveform cycle
is completed and the instrument stops and remains at the voltage level corresponding to the waveform's
starting burst phase. For a noise waveform, the output stops immediately when the gate signal goes false.
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Frequency Sweep

Frequency sweeping is similar to FM, but no modulating waveform is used. Instead, the instrument sets
the output frequency based on either a linear or logarithmic function, or a list of up to 128 user-specified
frequencies. A linear sweep changes the output frequency by a constant number of Hz per second, and a
logarithmic sweep changes the frequency by a constant number of decades per second. Logarithmic
sweeps let you cover wide frequency ranges where resolution at low frequencies could be lost with a linear
sweep.

Frequency sweeps are characterized by a sweep time (during which the frequency changes smoothly from
the start frequency to the stop frequency), a hold time (during which the frequency stays at the stop
frequency), and a return time (during which the frequency returns smoothly and linearly to the start
frequency). Trigger settings determine when the next sweep begins.
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Attributes of AC Signals

The most common AC signal is a sine wave. In fact, any periodic signal can be represented as the sum of
different sine waves. The magnitude of a sine wave is usually specified by its peak, peak-to-peak, or root-
mean-square (RMS) value. All of these measures assume that the waveform has zero offset voltage.

A waveform's peak voltage is the maximum absolute value of all of its points. The peak-to-peak voltage is
the difference between the maximum and minimum. The RMS voltage equals the standard deviation of all
waveform points; it also represents the one-cycle average power in the signal, minus the power in any DC
component of the signal. Crest factor is the ratio of a signal’s peak value to its RMS value and varies
according to waveshape. The table below shows several common waveforms with their respective crest
factors and RMS values.

If an average-reading voltmeter is used to measure the "DC voltage" of a waveform, the reading may not
agree with the DC Offset setting. This is because the waveform may have a non-zero average value that
would be added to the DC Offset.

You may occasionally see AC levels specified in "decibels relative to 1 milliwatt" (dBm). Since dBm
represents a power level, you need to know the signal’s RMS voltage and the load resistance in order to
make the calculation.

dBm = 10 x log
10

(P / 0.001) where P = VRMS2 / RL
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For a sine wave into a 50 Ω load, the following table relates dBm to voltage.

dBm RMS Voltage Peak-to-Peak Voltage

+23.98 dBm 3.54 Vrms 10.00 Vpp

+13.01 dBm 1.00 Vrms 2.828 Vpp

+10.00 dBm 707 mVrms 2.000 Vpp

+6.99 dBm 500 mVrms 1.414 Vpp

3.98 dBm 354 mVrms 1.000 Vpp

0.00 dBm 224 mVrms 632 mVpp

-6.99 dBm 100 mVrms 283 mVpp

-10.00 dBm 70.7 mVrms 200 mVpp

-16.02 dBm 35.4 mVrms 100 mVpp

-30.00 dBm 7.07 mVrms 20.0 mVpp

-36.02 dBm 3.54 mVrms 10.0 mVpp

-50.00 dBm 0.707 mVrms 2.00 mVpp

-56.02 dBm 0.354 mVrms 1.00 mVpp

For 75 Ω or 600 Ω loads, use the following conversions:

dBm (75 Ω) = dBm (50 Ω) – 1.76

dBm (600 Ω) = dBm (50 Ω) – 10.79
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Signal Imperfections

For sine waves, common signal imperfections are easiest to describe and observe in the frequency domain,
using a spectrum analyzer. Any output signal component with a frequency different from the fundamental
(or "carrier") is considered to be distortion. Those imperfections can be categorized as harmonic distortion,
non-harmonic spurious, or phase noise, and they are specified in decibels relative to the carrier level, or
"dBc."

Harmonic Distortion

Harmonic components occur at integer multiples of the fundamental frequency and are usually created
by non-linear components in the signal path. At low signal amplitudes, another possible source of
harmonic distortion is the Sync signal, which is a square wave with many strong harmonic components
that can couple into the main signal. Although Sync is highly isolated from the instrument's main signal
outputs, coupling can occur in external cabling. For best results, use high-quality coaxial cables with
double or triple shields. If Sync is not required, leave it unconnected or off.

Non-Harmonic Spurious

One source of non-harmonic spurious components (called "spurs") is the digital-to-analog converter
(DAC) that converts the digital waveform values into voltage. Non-linearity in this DAC gives rise to
harmonics that can be higher than the Nyquist frequency and will therefore be aliased to a lower
frequency. For example, the fifth harmonic of 30 MHz (150 MHz) could create a spur at 100 MHz.

Another source of non-harmonic spurs is the coupling of unrelated signal sources (such as the embedded
controller’s clocks) into the output signal. These spurs usually have constant amplitude and are most
troublesome at signal amplitudes below 100 mVpp. For optimal signal purity at low amplitudes, keep the
instrument’s output level relatively high and use an external attenuator.

Phase Noise

Phase noise results from small, instantaneous changes in the output frequency ("jitter"). On a spectrum
analyzer, it appears as a rise in the apparent noise floor near the frequency of the output signal. The phase
noise specification represents the amplitudes of the noise in 1 Hz bands located 1 kHz, 10 kHz, and 100
kHz away from a 30-MHz sine wave. Be aware that spectrum analyzers also have phase noise, so the levels
you read may include analyzer phase noise.

Quantization Noise

Finite resolution in the waveform DAC causes voltage quantization errors. Assuming the errors are
uniformly distributed over a range of ±0.5 least-significant bit, the equivalent noise level for standard
waveforms is approximately -95 dBc. At this level, other sources of noise in the instrument dominate.
Quantization noise can be of concern, though, in arbitrary waveforms that do not use the whole range of
DAC codes (-32767 to +32767). Scale arbitrary waveforms to use the entire range, if possible.
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Ground Loops

The signal-generation portion of the instrument is isolated from chassis (earth) ground. This helps
eliminate ground loops in your system and also allows you to reference the output signal to voltages
other than ground. The illustration below shows the instrument connected to a load through a coaxial
cable. Any difference in ground potentials (V

GND
) will tend to drive current IGND through the shield of the

cable, thus causing a voltage drop due to the shield’s impedance (Z
SHIELD

). This voltage (I
GND

x Z
SHIELD

)
appears as an error in the load voltage. However, since the instrument is isolated, there is a high series
impedance (typically >1 MΩ) in parallel with 50 nF) to oppose the flow of I

GND
and thereby minimize this

effect.

At frequencies above a few kHz, a coaxial cable’s shield becomes inductive, rather than resistive, and the
cable begins to act like a transformer. When this happens, voltage drops in the shield due to I

GND
tend to

be offset by equal voltages in the center conductor, thereby reducing the effects of ground loops at higher
frequencies. Coaxial cables with two or three braided shields are much better than those with single-
braided or foil shields because they have lower resistance and therefore become transformers at lower
frequencies.

To reduce errors due to ground loops, connect the instrument to the load using a high-quality coaxial
cable and ground it at the load through the cable’s shield. If possible, make sure the instrument and the
load are connected to the same electrical outlet to minimize further differences in ground potential.

Be aware that the outer shells of the Sync and Modulation In connectors are connected to those of the
main output connector(s). Cables attached to Sync and/or Modulation In are therefore potential sources
of ground loops. Also be aware that attempting to drive those connector shells to different voltages can
cause high current to flow through the instrument, possibly causing damage.
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